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1 Introduction

EzFrog

Advanced PAC solution for machine automation

EzProg-I for PAC IS

Motion Gontred | Logie Sonirol

EzProg-1 development suit is a software package for the windows CE 5.0 /6.0
platform consisting of numerous utilities and libraries which assist the system
developer in developing a control system on the PAC in a short period of time. The
development suit has got the following advantages for the user:

1. Simple and visually appealing 1/0 monitoring HMI can be created by dragging
and dropping of ActiveX objects, without the need of any programming.

2. Plc like programming by providing a predefined multitasking structure.

3. Extensive motion control libraries and utilities for writing motion control macros
which make it easy to write application programs for ICPDAS's multi-axis motion
control cards.

The EzProg-I development suite comprises:

Human machine interface (HMI) objects (ActiveX)
Configuration tools and utilities

10 libraries

Motion control tools and libraries

Libraries for serial and network communications




Powerful and Easy to Use

EzProg-I is a total solution for system configuration, logic programming and HMI design
for manufacturers or control system designers. Engineers who are familiar with
programming PLC systems can easily migrate to EzProg-1 and become acquainted with
the software solution. EzProg-I makes it much easier for customers to integrate PLC and
IT technologies.

The EzProg-1 package contains many kinds of development tools and libraries such as
EzConfig, EzGo, EzMake, EzHMI, EzLIB and EzCore. Based on these development
resources, customers can directly configure and test the PAC's 1/0 channels and motion
control modules without any additional programming effort. Moreover, EzProg-I
simplifies the 1/O instructions and provides 1/0 mapping table equivalent to the PLC
system. It assists the system developer to design, construct and test its control system.

EzProg-1 Applications

1/0 monitoring and logic control:
Building automation, SCADA, factory automation

Motion control:

Carving machine, Cutter, Laser carving, Laser cutting, Graphic plotter, Tapping machine,
Dispensing machine, Welding machine, Drilling machine , Punch machine, X-Y-Z table
control, coil wiring machine, automatic machine control

EzProg-1 total solution: e WinCE 5.0/6.0 real time 0S

e [Embedded low power
consumption controller

e [zProg-I development tools:
EzConfig, EzHMI, EzGo,
EzMake and EzLIB.

e Microsoft VC++ IDE develop
environment (Visual Studio
2008).

e Software protection and
license management




Integration of software and hardware:

The EzProg-1 was integrated on the hardware PAC (Programmable Automation
Controller), The PAC offer a lot of IO modules, communication interfaces, computer
interfaces, data storage device and so on. That can satisfy the need of industrial automatic

applications.

Real time framework:
EzProg-I priority level

PriorityT

]

Standard USB, VGA interface
Touch screen support

Data storage (1GB CF or Micro
SD)

Great number of IO modules
available

Multi-axis motion control modules
Easy to use APl command
Various communication
interfaces: Ethernet, RS-232 and
RS-485.

The EzProg-l is a real time
development framework. The
framework supports hardware
interrupt, eight software interrupt
service routine RTSR and eight
user threads. That can design
multi-thread control procedures on
the WinCE RTSO. The user can
design control function easily.
Base on this framework, those
multi-thread control procedures
will be executed by priority one by
one.

EzProg-I priority levels:
Interrupt
System task
RTSR task
User thread
HMI

aprLONE




Easy use to design GUI (HMI):
EzHMI provides a number of ActiveX controls which allows the programmer to create a
graphic interface on a WinCE system which an operator can use to control and monitor
machines and plants. A user interface can therefore be designed within a short period of
time especially when it comes to displaying digital and analog 1/0 data of the ICPDAS
8000 series.

\& " ICP DAS CO,, LTD.
DS mBERAHRLY

'ﬁ “ ICP DAS CO,, LTD. P
N zbsumniRad )

#EzCore ENGINE start OK !!

EzHMI ActiveX properties:

Direct display of 10 status
Direct display of register values
Multilanguage support

Support flashing (alarm)
Picture movement

Font setting

Color setting

Enable/disable objects




1.1 EzProg-I Software Development Resources

Requirements such as high performance, easy integration, extensibility, fast software
development and short time to market are an increasing demand of the industry. ICPDAS
offers the hardware and software solution to meet the demands. The EzCore engine
provided by ICPDAS is a development kit to simplify and reduce the software
development expenditure.

EzProg-I is a developing toolkit consisting of libraries, utilities and HMI controls for the
Windows CE 6.0 platform.

The basic structure of EzProg-I:

The lowest level consists of the real time WIinCE operation system and the
hardware driver

10 APIs and the MFC APIs are part of the next layer

One layer up is the main application layer comprising the EzCore, EzLib and
EzMotion libraries.

The top layer is made up of the control program compiled by VS2008, the human
machine interface (EzHMI) and configuration and testing utilities

EzHMI QLIS EzConfig
‘ VS 2008 Layer 4

EzCore | EzLib | EzZMotion Layer 3

Layer 2

: Laver 1
8K IO MPAC Windows CE 6.0 y



The normal development procedure is shown on the following figure.

_P Configuration(EzConfig)
XML Config Table

i
Real 10 Test

Check wiring HMI desien
' Function design

Yes
Test all system
Reliability Test Engineer

documentations

Libraries and utilities

EzCore

EzCore is the engine driving EzProg-1 and it is responsible for the communication
between the hardware (1/0), HMI controls and the registers. All libraries are compatible
with Visual Studio 2008.

EzCore has a real time scanning engine which supports hardware interrupt and direct
access of 10 registers and other system related registers. EzCore offers eight real time
interrupt service routine RTSR (similar to a task in a multitasking programmable logic
controller) and eight user threads.

10



EzCore system variables:

Specification Register Register number Data type| Size Range

£ | Digital Input . — 1003 . ;;;? b R

%’ Digital Output M o 080 = 7777 o [

§ Analog Output AO Local AO 0 ~511 float AEEs || 8dE«kE

% Analog Input Al Local Al 0 ~51 float dbytes | 34E + 38
Timer T Mone Retain: 1 =~299 kit 1 bit true / false
Counter C SE:;nRetam: 51; — f;;;; bit 1 hit true  false
Flag M SE:;nRetam: 819; — fgggg bit 1 hit true  false

N Step S Mone Retain 1 ~8191 bit 1 bit true | false

&

% | long integer D oo —ogs —7ags | Promeser | abes | TSRS

BT G o 7w Al M

& | woRo W e o] | 7 | oo
e — gggfetam 409(15 - gggi g | 4005 | e o
P TS T e | e
Special Type DB None Retain: 1 ~49
Message MSG Retain 1 ~249 30 wehar_t B0 bytes| 30 unicode char

EzCore main function:

EzCore has a real time scanning engine which supports hardware interrupt and direct
access of 10 registers and other system related registers. EzCore offers eight real time
interrupt service routine RTSR (similar to a task in a multitasking programmable logic
controller) and eight user threads.

11



EzHMI ActiveX

EzHMI ActiveX controls allows the programmer to design a user interface on a WinCE
system for monitoring and controlling purposes. The ActiveX controls can be directly
linked to 10 registers for displaying or manipulating of 10 data. In addition the ActiveX
controls support Multilanguage. EzZHMI objects use the EzCore platform to update data at
system run time.

EzLIB

EzLib is a collection of reusable software components and assists software developers to
write application programs for the Window CE platform.

APIs for:

Data format transformation
Date and time

Read/Write file

Context drawing

FTP communication
TCP/IP communication
Trend line graph

Motion Control development resources

EzProg-I supports the following 2 axis and four axis motion modules:

i8092F, 18094, i8094F, i8094A, i8094H.

EzGo and EzMake are utilities for configuring, programming and testing the motion
modules. For more information refer to the manuals for motion control.

12



2 EzProg-I framework

2.1 Application framework

The EzProg-1 main framework has the following layout:

Register Digital 1/0 Analog 1/0 Motion Other
SMT,.CD IN_Xa(Xno) IN_AI(Alno) API User
B,w,DW,F,.DB OUT_Y(Yno,on/off) i OUT_AO(AONo,Vout) API

LUSER.J _RTSR.J LInterrupt..

Figure 1: EzProg-I structure

System consists of three parts:
1. Top layer:
EzHMI provides a number of ActiveX controls which allows the programmer to
design a user interface on a WinCE system for monitoring and controlling
purposes. The ActiveX controls can be directly linked to 10 registers for
displaying or manipulating of 10 data. In addition the ActiveX controls support
Multilanguage.

2. Middle layer
EzProg-I has a section of memory called register where bit, integer, floating point
and string values can be stored and accessed. These registers can be accessed by
the upper and bottom layer. EzZHMI controls can be linked directly to a register
type and register number to access data.

3. Bottom layer

a. User thread: Programmer has to add code to the function. The code will be
executed only once

13



b. RTSR: Similar to plc coding. This API will be called at fixed time
intervals.

c. Hardware interrupt: The Interrupt has got the highest priority and
immediately interrupts the execution of other tasks. After the interrupt
handler has completed it execution code a function with a lower priority
will be executed.

2.1.1 EzProg-I Register

EzProg-I has a section of memory called register where bit, integer, floating point and
string values are stored and accessed. The register table is divided in two main parts: one
part stores 10 data from the slot modules (like the X,Y, AO, Al registers) and the other
part holds non 10 related values (e.g. M, D,F, MSG). The IO registers are updated every
milliseconds, that means the EzProg-1 engine scans every millisecond all D/A input
modules in the slots to update the X, Al registers and writes D/A data from the Y, AO
registers to the output modules. Use the EzConfig utility assist the system designer to
map 10 channels to register. EzHMI controls can directly access data from a register by
linking the control to a register type and number. EzHMI uses data from the register to
change the attributes of the on-screen controls.

uuuuuu

SET_M(WORD Mno, bool Flag):
GET Ma(WORD Mno);
GET_Mb (WORD Mno) ;

SET_D(WORD Dno, long Val);
GET_D(WORD Dmnoj 7

SET_F (WORD Fno, float FVal);
GET_F (WORD Fno);

SET_MSG(WORD M3Gno, TCHAR UMSG([30]):
GET_MSG (WORD MSGno, TCHAR UMSG[30]) ¢

Figure 2: Registers in the EzProg-I framework

14



The registers supported by EzProg-1 are listed in the following table:

Specification Register Register number Data type| Size Range
= . Local DI 0 ~777
% Digital Input X ST 1000 <7777 bit 1 bit trug / false
[=]
) L Lacal DO 0 ~777
b 1h Jfal
gl Dl Dl b FRNet DO, 1000 = 7777 ! to| meitse
L
g Analog Output AO Local AO 0 ~51 float dbyes | 34E 438
% Analog Input Al Local Al 0 ~511 float 4 bytes 34E +- 38
Timer T Mone Retair: 1 =~299 bit 1hit true / false
Mone Retain: 1 ~511
Counter C — 512 = 1023 bit 1 bit true / false
Mone Retain: 1 ~6999
Flag M —— 8192 =~ 15999 bit 1 hbit true / false
Step S None Retain 1 ~8191 bit 1 bit true / false
@
B . None Retain: 1 ~ 3599 ' —2.147 483,648
g | long integer b Retain 4096~ 7999 erotieest | 40 | 02147483647
I None Retain 1 ~699 unsigned
= 1 b Oto 255
s | BYTE B Retain 1024~ 2047 cher S
LS None Retain 1 ~1023 unsigned
] g 2b 0to 65,535
o e Retain 1024 ~ 1999 short e
Mone Retain: 1 ~4095 unsigned Oto
DWORD DW 4096 - 8191 long A0S | 4294967205
Mone Retain: 1 ~1899
f 4b 34E + 38
Pk 3 Retain 2048 - 3999 et s
Special Type DB Mane Retain: 1 ~49
Message MSG Retain 1 ~249 30 wchar_t 60 bytes| 30 unicode char

Table 1: Register types

The next table lists the APIs for accessing the registers:

15



Specification | Register Read from Register Write to Register
Digital Input X IN_Xa(X_RegisterNo); -

Digital Output Y GET _Ya(Y_RegisterNo); OUT_Y(Y_RegisterNo, Flag);
Analog Qutput AO GET_AO(AQ_RegisterNo); |OUT_AO(AO_RegisterNo, Value);
Analog Input Al IN_AI(A]_RegisterNo); -

Timer T GET_T(7_RegisterNo); SET_T(T_RegisterNo, Flag, Value);
Counter C GET_C(C_RegisterNo); SET_C(C_RegisterNo, Flag, Value);
Flag M GET_Ma(M_RegisterNo);  |SET_M(M RegisterNo, Flag);

Step S GET_S(S_RegisterNo); SET_S(S_RegisterNo);

long integer D GET_D(D_RegisterNo); SET_D(D_RegisterNo, Value);
BYTE B GET_B(B_RegisterNo); SET_B(B_RegisterNo, Value);
WORD W GET_W(W_RegisterNo); SET_W(W_RegisterNo, Value);
DWORD DW GET_DW(DW _RegisterNo); |SET_DW(DW_RegisterNo, Value);
Float F GET_F(F_RegisterNo); SET_F(F_RegisterNo, Value);
Message MSG  [Soiam amecan o e™>  |SET_MSG(MSG_RegisteriNo, TCHAR UMSGI30]);

Table 2: APIs for accessing registers



3 EzTemplate

The EzTemplate is a template for Visual Studio 2008 to enable a user which is neither
familiar with MFC nor Visual Studio 2008 to easily create a Window CE 6.0 application.
The EzTemplate provides all the necessary tools to start writing a real time logic
controller with a human machine interfaces. Direct DIO control via the user interface, for
example for displaying or setting a digital channel status, can be done without any
programming.

All the necessary libraries and header files are included in the project for the system
designer to make full use of the power of the EzHMI controls. Initialization and 10
scanning engine are activated by default. Easy to use programming interfaces are at
user’s disposal to unburden the programmer from understanding MFC and graphic
programming. Several user threads and real time service routine (multitasking) are
available to run the control program in a multitasking and deterministic environment.
Task cycle time and task priority can be set with ease. The EzTemplate includes 50
dialog pages (design windows). Dialog pages for the following screen resolutions are
provided:

= 640x480
= 800x600
= 1024x760

3.1 EzTemplate Setting

3.1.1 Pages
The EzTemplate provides up to 50 user windows (pages). The program developer has to
decide how many pages he needs in order to provide the operator with all the necessary
information and input capabilities to operate the control system.
The following steps describe procedure of setting of the number of windows:

STEP 1: Open the Solution Explorer: View = Solution Explorer.

View || Project Build Debug Tools Test W
[Z] Code Cirl+Alt+0

._:I |SolutionE><plorer Cirl+AlT+L |

17



STEP 2: Double click Ez_TemplateDlIg.cpp in the Solution Explorer.

Solution Explorer - Solution EzTe... - I X
= G S
[ Solution EzTemplate' (1 project) G
= EEzTemplate

& [ Header Files
& [ Resource Files
= & Source Files
¢ A_Template.cpp
& Ez Template.cop
| &1 EzTemplateDlg.cop |
& Page01.cop

STEP 3: The value of the PageCount definition represents the number of
independent dialog windows to be used for the program. The default
number of dialog is ten.

L1111777777777777777/77/77777////7777/////77///////7/7////777
//1//////777/777
#define PageCount 10 // 0~50 : maximum 51 pages

STEP 4.
Each dialog window is linked to an M register number. If the register of a
corresponding window is set to true, the window will be visible on the
screen. The main page “IDD_EZTEMPLATE_DIALOG” is linked by
default to M register 6000. For each page following the main page the
corresponding M register number is incremented by one.

#define M_Page 6000

—— M M register numbers:
[E100_EZTEMPLATE DIALOG | 6000
=l ID0_Page01 [Chirese (Taiwan)] #=——— 6001
=l IDD_Page02 [Chirese (Taiwan)] #=——— 6002
=] IDD_Page03 [Chinese (Taiwan)] #—— 5003
&l IDD_Page04 [Chinese (Taiwan)] d— 5004

=3 Dialog

The user can change the default M register setting. By using
#define M_Page 5000

The main page “IDD_EZTEMPLATE_DIALOG” is linked to M register
5000. The register numbers following the main window are automatically
are automatically assigned to the remaining windows.

18



3.1.2 Programming interfaces

To make the programming easier all the necessary programming interfaces are
provided in the A_Template.cpp file. These interfaces are a great help especially for
plc and ¢ programmers who are not familiar with MFC and graphic programming.
They significantly reduce the programming time by relieving the user from the
burden of studying Windows CE APIs. All the code for initialization and controlling

has to be implemented in this file. Programming code can be added to the following
functions:

= USER_INITIAL
= USER_THREAD O to 7
= Real Time Service Routine (RTSR O to 7)

To open the A_Template.cpp file in VS2008 go ahead as follows:

STEP 1: Open the Solution Explorer: View -2 Solution Explorer
View || Project Build Debug Tools Test W

[Z] Code Cirl+Alt+0

l—“g [Solution Explorer Crri+Al+L |

STEP 2: Double click A_Template.cpp in the Solution Explorer

Solution Explorer - Solution EzTemplat.. « L X
= ] A
A Solution EzTemplate' (1 project) »
= [ EzTemplate

- [ Header Files
#- [ Resource Files
= = Source Files
|&1A_Template.cop |
& EzTemplate.cop
¢ EzTemplateDlg.cop
¢ Page0l.cpp

3.1.2.1 Initialization

The main purpose of the USER_INITIAL(Q) function is to initialize registers and
variables at program start. The following example illustrates this.

void USER_INITIALQO
SET M(2,true); //Set M register number 2 to true
SET D(333, 10000); //Set D register number 333 to 1000

SET MSG(44, L"Hello'™); //enter a string to MSG register
//number 44

19



3.1.2.2 User Thread

The user thread API allows the programmer to write low priority code like updating the
user interface or other none time critical operations. The eight user threads each execute
their code in a separate thread. The thread priority of the user threads are fixed and can
not be changed in the program. The priority level decreases with increasing thread
number. USER_THREAD_O has the highest and USER_THREAD_7 the lowest priority.
The user thread can be called anywhere in the program by calling the
START_USER_THREAD API.

The following steps describe how to call the user thread at program start.
STEP 1: Open the EzTemplateDlg.cpp file
STEP 2: Go to the CEzTemplateDIlg: :OnInitDialog()in the EzTemplateDlg.cpp

file and remove the forward slashes // from the user thread you want to call
at program start. In the following USER_THREAD_3 s activated:

//===== Start USER_THREAD
//ret= START_USER_THREAD(O, USER_THREAD_0); //Run background
//ret= START_USER_THREAD(1, USER_THREAD_1); //Run background
//ret= START_USER_THREAD(2, USER_THREAD_2); //Run background
ret= START_USER_THREAD(3, USER_THREAD_3); //Run background
//ret= START_USER_THREAD(4, USER_THREAD_4); //Run background
//ret= START_USER_THREAD(5, USER_THREAD_5); //Run background
//ret= START_USER_THREAD(6, USER_THREAD_6); //Run background
ret= START_USER_THREAD(7, Tree_Page); //Run background

STEP 3: Open the A_Template.cpp file and add your code to the USER_THREAD_3

function
//===== Run UserThread3
unsigned long USER_THREAD_3(void *)
{

//Add your code here

//
END_USER_THREAD(3);
return _NO_ERROR;

20



3.1.2.3 Real Time Service Routine (RTSR)
This RTSR function is very similar to the tasks of a multitasking PLC. Every RTSR
function is being called at a set time interval. The priority settings of the eight RTSRs are
fixed. The priority level is decreasing from RTSR 0 to 7. RTSR_0 has the highest priority
followed by RTSR_1 and RTSR_7 has the lowest priority level.

RTSR_Interval_0

RTSR_Interval_1

Figure 3: Real time service routines (RTSR) with different priorities

3.1.2.3.1 RTSR Activation

RTSR_Interval_2

4

The following steps demonstrate the activation of a RTSR in the EzTemplate. In this
example the activation of the RTSR_4 function will be shown.

STEP 1: Open the EzTemplateDIg.cpp file.
STEP 2: The RTSR_4 calling interval time is defined in the #define section at the

beginning of the file. The default interval time for the RTSR_Interval_4

constant is 100 milliseconds. The user can change this value to suit his
requierements. The smallest interval value supported is 2 milliseconds. In this

example we assign RTSR_Interval_4 150 milliseconds.

//////////7////// For RTSR [////////7///7/////7////////////7/7/7/
ms RTSR

#define
#define
#define
#define
#define
#define

RTSR_Interval_O
RTSR_Interval_1
RTSR_Interval_2
RTSR_Interval_3

RTSR_Interval_4
RTSR_Interval_5

// 5
// 10
// 20
// 50
// 100
// 200

ms
ms
ms
ms
ms

RTSR
RTSR
RTSR
RTSR
RTSR

Interval
Interval
Interval
Interval
Interval
Interval

21



#define RTSR_Interval_6 500 // 500 ms RTSR Interval
#define RTSR_Interval_7 1000 // 1000 ms RTSR Interval
LI111177777777777/7/////////////////////////////////////////////77

STEP 3: Go to the CEzTemplateDIlg: :OnInitDialog()in the EzTemplateDlg.cpp
file and remove the forward slashes // from the //ret= START RTSR(4);
comment line

//===== Start RTSR
//ret= START_RTSR(0); //if you want use RTSR O
//ret= START_RTSR(1); //if you want use RTSR 1 remove this "//" comment
//ret= START_RTSR(2); //if you want use RTSR 2 remove this "//" comment
//ret= START _RTSR(3); //if you want use RTSR 3 remove this "//" comment

4

5

6

7

remove this ''//" comment

ret= START_RTSR(4); //if you want use RTSR remove this *"'//" comment
//ret= START_RTSR(5); //if you want use RTSR remove this ''//" comment
//ret= START_RTSR(6); //if you want use RTSR remove this "//" comment
//ret= START_RTSR(7); //if you want use RTSR remove this *"//" comment

STEP 4: Add your control code to the RTSR_4()function

void RTSR_1(Q)

// Add your code here
}

For each RTSR the scan time can be set. To ensure deterministic behavior of the RTSR it
IS important to make sure that the code in the RTSR is executed within the set time scan
interval. Therefore it is suggested not to call the Sleep API or use an endless loop inside a
RTSR.

If the interval is set to three milliseconds and a Sleep API is being called in the RTSR to
suspend the execution of the RTSR thread for more than three seconds the behavior of
the RTSR becomes nondeterministic. The same applies to an endless while loop, which
causes the execution of one RTSR cycle to run indefinitely. Also care should be taken
when loops are used which requires a lot of CPU resources. The execution time of a
RTSR can be Within the The interval time can be guaranteed execution time of a RTSR
can be reduced by avoiding Sleep, large “for” loops and by implementing small execution
code or by setting the time interval to a larger value.

void RTSR_1(Q)
for (int i=1, i<= 100; i++)
Sleep(10); € AVOID using Sleep inside a RTSR

// Execute some code

void RTSR_1()

while(true) € Do NOT use a infinite loop inside a RTSR
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// Execute some code

An infinite loop is a sequence of instructions in a computer program which loops
endlessly, either due to the loop having no terminating condition, having one that can
never be met, or one that causes the loop to start over. An infinite loop in a RTSR with a
high priority causes the entire system to become unresponsive as the loop consumes all
available processor time. The only way to end the loop is to power off the console.

EzCore provides the function GET_RTSR_TIME(BYTE RTSRno) to check whether the
execution time of the previous RTSR call exceeded the interval time. The following
example shows how to implement this function: compare the execution time with the
interval time, if the execution time exceeds the interval time generate an error message is
generated and abort execution of the remaining RTSR code.

void RTSR_4Q)

{
//Read the execution time of the previous RTSR 4 call
iT(GET_RTSR_TIME(4)> RTSR_Interval_4)
SET_MSG(1, L"RTSR_4 interval time exceeded!');
return;
}
// Add your code here
}

3.2 Priority Levels

The EzCore has got the following priority levels:

= Interrupt

= System task
= RTSR task
= User thread
= HMI

All priorities are fixed and can not be change by the programmer.
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PriorityT

X

User Thread

HMI

10

Interrupt User Thread
RTSR HMI and other

Figure 4: Priority levels of EzCore

Interrupt by hardware
A hardware interrupt causes the processor to save its state of execution and begin
execution of an interrupt handler. Hardware interrupts is a way to avoid wasting the
processor time in polling loops, waiting for external events. The Interrupt has got the
highest priority and immediately interrupts the execution of other tasks. After the
interrupt handler has completed it execution code a function with a lower priority will be
executed. Two API are provided for the interrupt:

= SET_INT(): assigning the interrupt a interrupt handler

= START_INTQ): setting the interrupt mode: falling or rising edge

The hardware interrupt is supported by the following modules
= DI module: 8094H in slot 1
= Motion module: 8094A, 8094F, 8092F (in slot 1 to 3)

Example:
#define INTP_MODE Rising 1
#define INTP_MODE_Falling 2

RET = SET_INT(O, &(ptTSRFunc)INTP_RUNO);
RET = START_INT(O, INTP_MODE_Rising):

// Interrupt handler:
void INTP_RUNOQ)

SET_D(1,GET _D(1)+1);

OUT_Y(0,GET_Yb(0));
3
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System task
The system task scans every millisecond the I/0 modules in slot 1 to 7 and update the

corresponding register.

RTSR task
The RTSR task is being called at fixed time intervals. The time interval can be set for
every RTSR task. Eight RTSR tasks with predefined priority levels are provided. The
priority level decreases from 0 to 7. The minimum interval time is 2 milliseconds.

= RTSR_O0Q - highest priority

* RTSR_1Q)

= RTSR_2Q)

= RTSR_30

= RTSR_4Q)

= RTSR_5Q)

= RTSR 60

= RTSR_70 - lowest priority

User thread task

The task priority is decreasing with increasing user thread number.
= USER _THREAD 0() = highest priority

USER_THREAD_1()

USER_THREAD_2()

USER_THREAD_3()

USER_THREAD_4()

USER_THREAD_5()

USER_THREAD_6()

USER_THREAD _7() - lowest priority

HMI
The updating the user interface has the lowest priority.
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4 EzHMI

EzHMI is a package of ActiveX controls for the Windows Embeddede CE 6.0
environment containing different kind of buttons, switches, knobs, sliders, gauges which
can be used in many industry applications and simulation environments. It is designed to
visualize and integrate the real-time process and production data. EzZHMI releases the
developer from designing graphic components and thereby speeds up the project
developments involving SCADA systems, HMI and simulations. It allows the developer
to fully focus on programming the logic control. The user interface can be fully customer
configurable which supports customer-provided picture. Developers can design a graphic
interface on a WinCE system to their dialog boxes, using a variety of shapes, surfaces,
textures, bitmaps and icons, colors and fonts.

4.1 EzHMI ActiveX overview

Symbol Name Picture

The LED is used to visualize boolean discrete status:
= ON/OFF
=  True/False

@ LED

= Active/Inactive
=  Open/Closed
A text label can be added to the control.

SWITCH

S acalo=

The switch is used to input and visualize two statuses at runtime:
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= ON/OFF

*  True/False

*  Active/Inactive

»  Pressed/ not pressed.

The switch can be labeled with a text.

) Label

You can enter one or several lines of text in a LABLE box and define
the font width and color. You can add a background color or pattern to a

text box.

A LABLE control can be set to display at runtime
= Name or caption
=  Value

= Text message

b ColorEdit

A ColorEdit box have the following runtime functions:

= Input/output of values
= Input/output of text
You can define the limits for the input values.

User input can be disabled at runtime.

ButtonST
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C)

Image

ColorRadio

'
| ol

The ButtonSt triggers an event, notification or acknowledgement when it
is being clicked or released. The implementation of the button event has
to be done in ¢ or c++ programming language. The operator can use a
button to control a process. Images can be added to the button without
any programming effort.

The Image control displays graphic objects on the screen which has
been created by a graphic software. Only graphic images saved as
"+.bmp" can be shown. In addition more than one image can be attached
to a control. During runtime the image itself can be replaced by another
image and the position of the image can be changed. Functions are
provided to move the image across the screen.

©0.ltem1 @ 5.Item1
® 1 .Item1 @6.ltem1
@ 2.Item1 27 tem1
@ 3.Item1 28.ltem1
@ 4.Item1 29.tem1

A ColorRadio control allows the operator to choose only one of a
predefined set of options. When the operator selects an option, any
previously selected option in the same group becomes deselected.
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[

<

ColorCheck

EzKnob

EzSlider

I:I Messaged

0.ltem1
[ 1.ltem1
2 Item

[ 3.Item1

[ 4.ltem

5.ltem1

[ 6.ltem1

OK

Cancel

The ColorCheck allows the selection of several items.

103

102 /5

10172

100

104 17

N

107
13
12

3, 105

10

15
106
14

The EzKnob visualizes data like pressure, temperature, volt, etc. in form
off a multi—needle gauge. The EzKnob object also allows the user to
manually input values by dragging the needle (via mouse or touch
screen) to the desired position on the scale. This ActiveX can be
directly linked to analog I/O channel.
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The EzSlider represents a process value in the form of a scaled bar.
The slider bar allows you to visualize or enter dynamic values
(temperature, filling levels, pressure, etc.). New values are entered by
sliding the indicator to required value.

= EzList
2009/03/16 15:24:30 BrSEIFZHAE
2009/03/16 15:24:28 #BISEIFEHE
2009/03/16 15:24.25 BrSEIfZHE
2009/03/16 15:24:22 BrSEIEHE 5
The EzList outputs messages during runtime. Each message can be
provided with a date and time stamp. New messages are automatically
added to top of the list.
= Position
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Table 3: EzZHMI controls

The Position control is used for motion control applications. It can be
set to display one of the following motion parameters:

= Logic Position
= Encoder Position
= Velocity

=  Acceleration
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4.2  Settings

4.2.1 Visual Studio 2008 IDE

4.2.1.1 Adding EzZHMI ActiveX controls

In order to use the EzHMI controls for the EzTemplate project the EzHMI ActiveX have
to be added to the VS2008 toolbox. The following steps describe the procedure:

STEP 1: Click View = Resource View

Wproject Build Debug Format Tools
[Z] | Code Cirl+Alt+0
D_? Solution Explorer Cirl+Alt+L
% | Bookmark Window Cirl-+K, Cirl+w
g Class View Ctrl+Shift+C
3 Code Definition Wirdow  Cirl+Shift+y
9 Cbject Browser Crl+Alt+]
=] ouput Alt+2
,j, Property Manager

La—l Resource View Ctrl+Shift+E |

STEP 2: Double click the “IDD_EZTEMPLATE_DIALOG” resource. The dialog
sheet will appear.

Resource View - EzTemplate
=24 EzTemplate A
=1 EzTemplate.rc*
=-d Dialog

=|ICC_EZTEMPLATE_DIALOG |
=l IDD_Page0i
DD_Pagel?2
DD_Pagel3

&=
&=

STEP 3: Click View = Toolbox to display the toolbox
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I\a‘ieWIProject Build Debug Format Tools

[Z] Code Cirl+Alt+0
-:' Solution Explorer Chri+Alt+L
b Bookmark Window Cirl+K, Cirl+W
B Class View Clrl+Shift+C
; Code Definition Window  Cirl+Shift+V
@ Cbject Browser Cirl+Alt+]
=] output Alt+2
ﬂj, Property Manager

,_3| Resource View Ctrl+5Shift+E
> Toolbox Cirl+Alt+X |

STEP 4: Right click the toolbox and select “Add Tab” from the popup window. Enter
“EzHMI” as a tab name and press enter.

7 Date Time Picker

| Month Calendar Confrol |
€ Custormn Confrol

Abl CAPEdit Control

B8 State of Input Parel Control

= EzHMT] |

There are no usable confrols in this group, Crag
an item onto this text to add it to the toolbox,

+ General v

STEP 5: Click on the EzZHMI tab

STEP 6: Click Tools = Choose Toolbox Items ...
Tools | Test  Window Help
_"‘L Attach to Process... Crl+Alt+P

|,
s o

Device Security Manager ...
gl;- Connect to Device. ..

__L'-_fi‘ Device Emulator Manager ...
*}’_]; Connect to Database. ..

“:3 Conrect to Server..,

:__'] Code Snippets Manager...  Chrl+K, Cirl+B

| Choose Toolbox Items...

It will take some time before the “Choose Toolbox Items” dialog window pops up.

STEP 7: Click the “COM Components” tab.

STEP 8: Select from the “COM Components” list the 12 EzHMI ActiveX controls
and click “OK”.
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NET Framework Components| COM Compenents [WPF Components | Activities

MName Path Library e
1 DTC Designer C\Program Files\Microsoft Wisual Studi... Microsoft BDTC Fra...
EzHMI ButtonsT Control (ICP-DAS Y, CAICPDAS\EzProg-INOCK\ButtonST .ocx ButtonST Activel ..
EzHMI ColorCheck Control (ICP-DAS ... CAICPDAS\EzProg-INOCXNCOLORC~1.,.. ColorCheck Activ... |
EzHMI ColorEdit Cortrol (ICP-DAS Y., CAICPDAS\EzProg-INOCKA\COLORE~1....  ColorEdit Activex ..
EzHMI ColorRadio Control (ICP-DAS ... CAICPDAS\EzProg-IN\OCX\COLORR~1,.,.  ColorRadio Active. ..
EzHMI Ezkinob Control (ICP-DAS W2.2) CAICPDAS\EzProg-I\OC X \EzKnob .ocx knob Activex Con..,
EzHMI EzList Control (ICP-DAS W2.2)  CAICPDAS\EzProg-TNOCK \EzList.ocx EzList Activex Co...
EzHMI EzSlider Confrol (ICP-DAS W2.2) CACPDAS\EzProg-INOCK\EzSlider OCx. SLIDER Activex C...

[
[
[
[
[

[
EzHMI Image Control (ICP-DAS W2.2)  CAICPDAS\EzProg-INOC X\ mage.ocx Image ActiveX Co...
EzHMI Label Confrol (ICP-DAS W2.2)  CAICPDAS\EzProg-TYOCKabel .ocx Label ActiveX Con...
EzHMI LED Control (ICP-DAS W2.2) CAICPDAS\EZProg-INOCK\LED .ocx EzHMI LED Contr...
EzHMI Position Control (ICP-DAS W2.2) CAICPDAS\EzProg-I\OC XK \Position.ocx Position Activex ...

EzHMI Switch Control (ICP-DAS W2.2)  CAICPDASYEzProg-TYOCK Switch.ocx EzHMI Switch Co... |

< [ >
-1 WideoSoft FlexArray Control
. Language:  Language Neutral
\ersion: 3.0
l oK ‘ [ Cancel l l Reset l

Figure S: Load EzHMI controls to the toolbox of VS2008

All the selected controls will be displayed beneath the EzHMI tab.
= EzHMI
k Painter
EzHMI ButtonST Control (ICP-DAS W2.2)
B¢ EzHMI ColorCheck Control (ICP-DAS 42.2)
8 EzHMI ColorEdit Confrol (ICP-DAS V2.2)
(® EzHMI ColorRadio Control (1CP-DIAS W2.2)
T EzHMI EzKnob Control (ICP-DAS W2.2)
£ EzHMI EzList Contral (ICP-DAS VW2.2)
T EzHMI EzSlider Confrol (ICP-DAS V2.2)
& EzHMI Image Confrol (ICP-DAS Y2.2)
B EzHMI Label Control (ICP-DIAS V2.2)
@ EzHMI LED Control (ICP-DAS V2.2)
F5e EzHMI Position Control (ICP-DAS 42.2)
(@ EzHMI Switch Control (ICP-DAS V2.2) |

Figure 6: EZHMI controls in the toolbox
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4.2.1.2 Adding ActiveX controls to dialog resource

To add a control to the design surface and set their properties follow the next
steps:

STEP 1: Select from the toolbox the required control by clicking once on it.

STEP 2: Indicate with a click on the design surface the upper left position of the
control.

STEP 3: Right click the control and select from the pop-up menu “Properties”.

STEP 4: On the “Properties” window click the “Properties Pages” icon.

Properties -+ 1 X
Label -
ENEEA S|

[About) A

AlarmTimer 2

b B Elack

Caption LabelCtr|1

Captioni Captioni

Caption2 Captionz

Caption3 Caption3

STEP 5: Now you can do the necessary configuration on the “Properties Pages”.
Note: Do NOT set the EzHMI control properties directly in the
“Properties” window. Always do the setting on the “Properties Pages”.

4.2.2 Refresh Time

In order to increase the performance of the system it is important to define refresh time
carefully. Here are some guidelines for configuring the refresh time:

Select the refresh time in such a way that it reflects the rate at which the process
variables change. Each EzZHMI control can be set to a different refresh time. For
example, displaying the ambient temperature the scan rate can be set to more than
1 minute as the temperature changes slowly and is not likely to change suddenly.
On the other hand, a digital point that is monitoring the on/off state of a valve
would need a shorter scan rate to accurately reflect the current valve status.

As a good engineering practice, select the slowest possible scan rate that is
acceptable for your application. This will help prevent the system from being
overloaded by needlessly scanning processes.

If the user interface has a large amount of EzHMI controls select a lower scanning
speed otherwise the graphic interface will not be updated within the refresh time.
Always remember that the priority for updating the EzHMI controls is lower than
the priority for the controlling process (RTSR or ISR). Therefore if your
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controlling process is very CPU intensive less CPU resource will be available for
handling the graphic refreshing. In this case it is more reasonable to use a low
scan rate.

4.2.3 Language Switching

EzHMI allows you to configure a multilingual project. Up to eight languages can be
loaded simultaneously onto the HMI device. You can switch between the individual
languages at runtime. Language switching can be used on almost any EzHMI control. By
default language switching is not activated. To enable language switching on a control,
first add a EzHMI control to the design surface and in the property panel check the
“Display Status Text” checkbox. Make sure that the update rate (“Flash Timer 0,1,2 ...”)
is set to a value greater than zero.

The following EzHMI controls support Multilanguage:

= LED

= SWITCH

= Label

=  ButtonST

=  ColorCheck

At design time you have to determine how many languages your program needs to
support and assign each language an index from 0 to 7. It is suggested to create a table
which lists the different languages with their assigned indexes. Every EzHMI controls
which supports Multilanguage input provides edit boxes with labels from 0 to 7. Make
always sure that the text is edited in the correct edit box by comparing the language index
and text field index. Both indexes have to be identical. Throughout the project it is
required to stick to one language numbering otherwise there will be a mismatch of
languages.

i;:l(;legxuage Language Edit Box Index
0 English 0.
1 Traditional Chinese 1.
2 Simplified Chinese 2.
3 Japanese 3.
4 German 4.
5 Spanish 5.
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6 French 6.

7 Portuguese 7.

Table 4: Language mapping

English
Multi-Language Caption: 9
Font... l | / Deutsch
Fa
[¥] Display Caption Language 0. N Language b
play L.ap Language 1. | — HaC
Valve 1 P9 1 Language 2.~
0. vawe 1. ™ taﬂguagei-—-——b El Espanol
angquage 4. s,
e 0 Language 5. T — :
2. A1 3. JULT1 Language 6. ltaliano
Language ?‘\
4. Ventil 1 5, Vélvula 1 \ Frangais
6. Valve 1 7. Valvula 1 Py’cckun
H A

Enter the text to be displayed on the control in different languages to the textboxes (0 to 7)
of the “Properties Pages”. Each language textbox (0 to 7) represent a different language.
The default text is set by selecting a language from drop-down list. In the figure above
language “Language 0.” is selected as the default language.

During runtime one of the eight languages (0 to 7) can be selected by
1. using EzHMI color radio control (see tutorial)
2. calling the SET_D(Q) API in ¢ code (see tutorial).

SET _D(WORD Dno, long Val);

with
Dno = 8000
Val = textbox number O to 7
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4.2.4 Register linking

EzHMI parameters and some properties have to be linked to registers during design time.
Register linking can be one way or bi-directional, that is to say that some parameters and
properties can only read data and others can both read and write data to the assigned
registry. The table below gives an overview of the register types the different EzHMI
controls can be linked to.

Property Registertype LED SWITCH Label ColorEdit ButtonST Image
Digital Input:| X Read - o o - -
Digital Qutput:| Y Read Read/Write
Status Register (on/off) T 5/ T} Read =
Counter:| C Read - o -
Flag:| M Read Read/Write Read/Write | Read/Write
Step:| S Read - - o -
Analog Input| Al - Read -
Analog Output| AQ Read Read/Write -
Value Register Long Integer:| D Read Read/Write Read
Float| F Read Read/Write -
BYTE| B - -
String Register Message MSG - - Read Read/Write o
Language Setting D8000| D Read Read Read - Read
Disable ActiveX Flagl M - Read - Read Read -
Hide Control Flag M - - - Read
Property Registertype ColorRadio | ColorCheck EzKnob EzSlider EzList Position
Digital Input:| X - - - - - -
Digital Qutput:| Y
. Timer:| T
Status Register (on/off) Counter:| C - - .
Flag:] M Write Write Read/Write
Step:| S - - o o -
Analog Input| Al Read Read
Analog Output| AO - Read/Write Read/Write
Value Register LongInteger:| D | Read/Write Read/Write | Read/Write
Float| F - - Read/Write Read/Write
BYTE| B Read/Write = o -
String Register Message MSG - Read
Language Setting D8000| D - Read - -
Disable ActiveX Flagl M Read Read Read Read -
Hide Control Flag M - - - - Read

Figure 7: Registers accessed by EZHMI objects
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4.3 EzHMI ActiveX Controls

At present ICPDAS provides the following EzZHMI controls:

4.3.1 LED Control

4.3.1.1

Description

The LED control can be used for indicating the following statuses

on/off status,

digital 1/O status,

over / under limit status,
alarm, emergency,

= event,
= flag,
Setting:
In the following the configuration interface of the LED control will be discussed in more
details:
Appearance Styles: Multi-Language Caption:
‘LED Type: RECTANGLE v l Font...
‘Burder Style: NONE v [ 1Display Caption Language 0.
0. 1.
2 3
4 5
6 7
Color: Register Type and Number Assignment:

‘Status Text On Color:

‘Status Text Off Color:

‘ON Color:

‘OFF Color:

‘BackGruund Color:

‘Select XM/SITIC RealDI X

’X/Y:’Mfsrr /Cno -->LED(On/Off) 00000000

Refresh Interval (Unit 50ms):

‘ ‘Flash Timer 0,1,2.... 00000002

v
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4.3.1.2 LED Appearances

The LED control supports three types of shapes
— Rectangle
— Diamond
— Round

And the following border styles:
— None
— Raised
— Lowered

The color of the LED for displaying the ON and OFF status can be selected by
clicking the color box next to the “ON Color” and “OFF Color”. In addition the
background color of the LED is selectable.

Appearance Styles:

DIAMOND
‘LED Type: RECTANGLE v| |RECTANGLE

ROUND

‘Burder Style: NONE v

NOME
RalSED
LOWERED

RECTANGLE DIAMOND ROUND

-
S

4.3.1.3 Caption

Each LED can be labeled with a caption text in 8 different languages. During runtime

the caption text can be changed to a different language. To display a caption on the
LED

— Check the “Display Caption” check box

40



— Type in one or more text boxes (0 to 7) the caption text in different

languages

— Set the caption text font and size by clicking the “Font...” button
— Set the text color for the ON and OFF status by clicking the color button
next to “Status Text On Color” and “Status Text Off Color” and selecting

the desired color.

— Selected from the language combo box the default language.

Multi-Language Caption:

l Font...

[v] Display Caption Language 0. v
play Lap

0. Valve 1 1 [T

> AN 5 [T

4. Ventil 1 5. Yalvulal

6. Valve 1 7. Valvula1

4.3.14 Flash Timer

Refresh Interval (Unit 50ms):

Flash Timer 0,1,2..... 00000002

Cdl

Language 0. -

Language 1.

Language 2. ="

Language 3.

Language 4. |
Language o
Language 6. \

Lanquage 7,

J 11\

N

English

Deutsch

L

El Espanol

ltaliano

Frangais

Py cckui

HZ4<s%

The task of the flash timer is to update the status of the LED display at fixed time
intervals. The unit of the flash timer is 50 milliseconds. A flash timer value of two

will update the LED status every 100 milliseconds.

If the flash timer setting is zero, the LED control will not be updated during the
program execution time and the system language setting can not be changed during
runtime. The control will not read any register it has been assigned to and therefore
will not react to any register status change. To ensure that the LED control is updated
in regular intervals an integer number greater than 0 has to be entered. The default

value is 100 milliseconds.
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4.3.1.5 Register assignment

A LED control can only read a status register (X/Y/M/S/T/C). The following steps
describe the linking of a LED control to a register:

STEP 1: The first step is to select a proper register type for the LED control. Select
from the combo box “Select X/Y/M/S/T/C” the required register type.

STEP 2: Then enter in the “X/Y/M/S/T/Cno->LED(on/off)” a register number
according to the register table.

Specification | Register Register numbers
Register Type and Number Assignment: Digital Input X :E:ftl;\ 1003 : ;;;7
Select XYM/S/T/C [RealDIX v —> EE_Z‘}%'_OXY A Digital Output % ER o
Mfwsmcnu ~SLED(OwoOR) 00000000 EE;EEE g Analog Output | AQ | Localio L
Register C Analog Input Al Local Al 0 ~51
\ Timer T None Retain 1 ~299
Counter c :Z::ng - 51; . : :);3
Flag M :Z::np = 319; z fgggg
Step s Nene Retain 1 ~8191

X and Y register stores data of digital 10 modules plugged in slot 1 to 7. The mapping of
the register number with the digital 10 modules is done by the EzConfig utility. To
choose a correct X or Y register number please consult the I0_Table generated by the
EzConfig utility. No additional coding is required when a LED control is directly linked
to a 10 module register (X, Y).

Choosing register types T, C, M and S for the LED control requires the user to write ¢
code in the UserThread, RTSR or ISR to set the register to true or false. This is being

done by calling the following APIs:
= SET T (WORD Tno, bool Flag, DWORD Tval)
= SET_C (WORD Cno, bool Flag,DWORD COUNT);
= SET_M (WORD Mno, bool Flag)
= SET_S (WORD Sno);

If the LED control is not mapped to a valid register number it can not update its status as
it has no valid source.

Notice that the XY register start from zero.

Make sure that a register number greater than zero is assigned for Register M, Register S,
Register T or Register C otherwise the LED control is not mapped correctly and can not
update its status.
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4.3.2 Switch

4.3.2.1 Description

The EzHMI SWITCH control displays two statuses: “ON” (true) or “OFF” (false).

A SWITCH control reads, sets and displays the current status of a Y, M register. The
mapped register can be set either to true or false. Clicking the EzZHMI SWITCH causes
the switch to write the opposite status to the register. If for example the current status of a
register is true and the switch is activated, it will change the register to false.

A switch mapped to a digital output Y register can read and change the output state of a
device (e.g. a motor, valve, etc.) connected to the mapped output channel. Clicking the
SWITCH on the HMI automatically changes the state of the connected device.

Layout
The following types of switches are supported:
- LED
— Lever
— Rectangle
— Round
— Toggle

LED Lever Rectangle Round Toggle

Switch 1
I

L

EL

Setting:
In the following the configuration interface of the SWITCH control will be discussed in
more details:
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Appearance Styles:

Multi-Language Caption:

BackGround Color

Switch Type: 'SWITCH LED v/ ‘ Font ‘
Color: [] Display Caption |Language 0. v |
| Status Text On Color

0. | |1 | |
| Status Text Off Color

2. | EX |
| ON Color
| OFF Color 4| En |
| 6 | | 7. | |

4.3.2.2

Register Type and Number Assignment:

[]¥/M Enable
Select Y/M

| Switch(On/Off) > Y/Mno ‘

|Mnu(0n) --> Lamp ‘

Control Status:

Mno(On) --> Disable ActiveX ‘

Refresh Interval (Unit 50ms):

Flash Timer 0,1,2.... ‘00000002

SWITCH Appearances

The SWITCH control supports the following shapes:

LED
Lever
Rectangle
Round
Toggle

Appearance Styles:

Switch Type: SWITCH LED

SWITCH LED
SWITCH LEVER
SWITCH RECTANGLE
SWITCH ROUND
SWITCH TOGGLE
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LED Lever Rectangle Round Toggle
= I &

The color for displaying the ON and OFF status can be selected by clicking the color
box next to the “ON Color” and “OFF Color”. In addition the background color of
the SWITCH is selectable.

4.3.2.3 Caption

Each Switch can be assigned with a caption enabling the user to clearly identify the
LED on the HMI. During runtime the caption text can be changed to a different
language.

Different Switch styles with caption:

| - -

Approach to display a caption on a SWITCH object:

Check the “Display Caption” check box.

— Type in one or more text boxes (0. to 7.) the caption text in different
languages.

— Set the font and size of the caption text by clicking the “Font...” button

— Set the text color for the ON and OFF status by clicking the color button
next to “Status Text On Color” and “Status Text Off Color” and selecting
the desired color.

— Selected from the language combo box the default language.
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Multi-Language Caption:

Display Caption
g, |Valvel 1. FaF3 1
o (@71 AL
4. |Ventil1 5 Valvulal
g. |Valvel 7. [Valulal
4.3.2.4 Flash Timer
Refresh Interval {(Unit 50ms):
Flash Timer 0,1.2..... 00000002

Font... ‘
Language 0. V_bn a’

Language 0.7
Language 1.
Language 2-
Language 3
Language 4
Language 5.
Lanquage &

Language 1\

The SWITCH control flash timer has basically two tasks:
1. Switch state has been changed: Update the corresponding register to the new
switch status.

2. Register state has been changed: Redraw the SWITCH to display the new
register state.
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The flash timer reads from and writes to the status register at the set time interval.
The unit of the flash timer is 50 milliseconds. A flash timer value of two will update
the SWITCH display and register status every 100 milliseconds.

If the flash timer setting is zero:
— the SWITCH control will not be updated during the program execution time,
— the language setting can not be changed during runtime,
— the control will neither read from nor write to the register it has been assigned to.
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To ensure that the SWITCH control and the register are updated in regular intervals
an integer number greater than 0 has to be entered.

4.3.2.5

Register assignment

A SWITCH control can read from and write to a Y/M status register. The following
steps describe the linking of a SWITCH control to a status register:

STEP 1: Select a proper register type for the SWITCH control. Select from the combo
box “Select Y/M” the required register type.
STEP 2: Then enter in the “Y/Mno->LED(on/off)” a register number according to the

register table.

Register Type and Number Assignment:

¥/M Enable

Select Y/M

| Switch(On/Off) --> Y/Mno

|Mnu(0n) --> Lamp

Control Status:

Mno(On) --> Disable ActiveX

Register Type and Number Assignment:

[¥]Y/M Enable

iSelect Y/M

| Switch{On/OIf) --> Y/Mno

RealDOY v
00000000
00000000
00000000
Specification Register Reﬂls’:er numbers
_ Local DO 0 ~777
Digital Output Y FRNetDO. | 1000 ~ 7777
Rk iR | none Retain | 1 ~6999 |
'R_—{»_M_ lone Retain ~
e ’| HEE, M [Rean | #1902 ~15098 |

X and Y register stores data of the physical DIO modules in slot 1 to 7. The mapping of
the register number with the DIO modules is done by the EzConfig utility. To choose a
correct X or Y register number please consult the 10_Table generated by the EzConfig
utility. No additional coding is required when a LED control is directly assigned to a DIO

module register (X, Y).

Choosing register types T, C, M and S for the LED control requires the user to write ¢
code in the UserThread, RTSR or ISR to set the register to true or false. This is being

done by calling the following APIs:

= SET T (WORD Tno, bool Flag, DWORD Tval)
= SET C (WORD Cno, bool Flag,DWORD COUNT);
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= SET_M (WORD Mno, bool Flag);
= SET_S (WORD Sno);

If the LED control is not mapped to a valid register number it can not update its status as
it has no valid source.
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4.3.3 EzHMI Lable

4.3.3.1 Description

A LABLE control can be set to display at runtime
— the current value of an assigned register (Al, AO, D, F)
— or atext message of an assigned register (MSG)
— or afixed name or caption.

The LABLE control can have one of the following two states:
— Flashing:
The LABLE object starts to flash at a set time interval when a set
condition has been met.
— Static:
A new value or text message will be displayed in the set color.

Setting:
In the following the configuration interface of the LABLE control will be discussed in
more details:

49



Appearance Styles: Multi-Language Caption:

Frame: [ Client edge Language 0. 3
[] Static edge Ul abelCir1 1. |Captionl
[ | Modal frame 2. |Caption2 3. Caption3
Captiond Captionb
Align Text: DT CENTER »| 4 G@ption 5. Caption
6. Captionb 7. Caption?
[IMSG/AI/AO/D/F Enable
Color: Register Type and Number Assignment:
Back Color: B 5o'cctMsc/AvAoDrF
Font Color MSG/AVAO/D/Fno --> Label
|Decima| Point:
|Upper Limit:
|Luwer Limit:
Refresh Interval (Unit 50ms):
Alarm Timer 0,12..... 00000000
Flash Timer 0,12,..... 00000002
4.3.3.2 LABEL Appearances

The LABEL control supports the following border styles:

None

Client edge
Static edge
Modal frame

Labelctrl1 ‘_——,7
Client edge

Labakcirlz A Static edge

‘__,.—F Modal frame
LabelCtrl3

Labelctrla - — None
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4.3.3.3 Caption

Each LABLE support caption text in 8 different languages. During runtime the
caption text can be changed to different languages. To display a caption on the
LABLE
— Uncheck the “MSG/AI/AO/D/F Enable” check box.
— Type in one or more text boxes (0 to 7) the caption text in different
languages.
— Set the caption text font and size by clicking the “Fonts” tab
— Set the text and background color by clicking the color button next to
“Back Color” and “Font Color” and selecting the desired color.
— Selected from the language combo box the default language text (0 to 7) to
be displayed.
— Align the text by selecting DT_RIGHT, DT_CENTER or DT_LEFT from
the combo box
— Set the “Alarm Timer 0, 1, 2...” to zero for a static caption. A blinking or
flashing text to indicate an alarm is achieved by entering a number greater
than zero for the “Alarm Timer 0, 1, 2...”. The time unit is 50
milliseconds. For example: a value of 4 causes the LABLE to flash every
200 milliseconds.

Safety Valve 1:

Multi-Language Caption:
Language 0. v
0. |Safety Valve 1: 1. TR
2. B2 1: 8. TR/ 1: —
4. Sicherheitsventil 1: 5. Valvula de Seguridad 1: Sicherheitsventil 1:
6. Soupape de sécurité 1: 7. Valvula de Seguranga 1: \

Soupape de Sécurité 1:

Valvula de Seguridad 1:

Valvula de Seguranga 1:
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4.3.34 Register assignment

A LABEL control can read values or text messages from the assigned register (Al,
AO, D, F, MSG). The following steps describe the mapping of a LABEL control to a

register:
STEP 1: Check the “MSG/AI/AO/D/F Enable” check box
STEP 2: Select a proper register type for the LABEL control. Select from the
combo box “Select MSG/AI/AQO/D/F” the required register type.
MSG/AVAD/D/F Enable >
F:egister Type and Number Assignment: >
bﬂ'ﬂﬂt MSG/AKAD/D/F Register D v | Specification | Register Register numbers
[MSG/AI/AO/D/Fno --> Label 00000000 | Analog Output AO Local AO: 0 ~511
|Dec:ima| Point: 0 Analog Input Al Local Al 0 ~511
Upper Limit: 20000000000
Lower Limit: -20000000000 long integer D EZ::I:MM' 409; :g:gg
Refresh Interval (Unit 50ms): Float B TR 1 ~1899
lAIarmTimerOJ,Z.... 00000000 e Retain: 2048 ~ 3999
Flash Timer 0,12...... 00000002 | T— se | o PE—

STEP 3:

STEP 4:

STEP 5:

STEP 6:

Enter in the “MSG/AI/AQ/D/Fno ->Label” edit box a register number
according to the register table.

Set the LABEL control update rate in the “Flash Timer 0,1,2...” edit box.
The Flash timer reads values or text messages from the mapped register at
the set time interval. The unit of the flash timer is 50 milliseconds. A flash
timer value of two will update the LABEL display every 100 milliseconds.
If the flash timer setting is zero, the control will not be updated during the
program execution time. The language setting can also not be changed
during run time.

In case a float or long integer register type (“Al/AO/D/F”) has been
selected:
= Set the number of decimal places to display

If you want the control to flash or blink to indicate an alarm the following
additional settings have to be made:
= Enter a blinking frequency value for the “Alarm Timer 0, 1, 2...”
(Unit: 50 milliseconds). If this timer is set to zero the blinking
property is disabled.
= In case a float or long integer register type (“Al/AO/D/F”) has
been selected:
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— Enter a safe range by assigning a value for the upper
and lower limit. Once the value in the mapped register
exceeds the range the control starts to flash.

In case a message register type (“MSG”) has been selected:

— Only messages in the MSG register which starts with a
“#” character will flash in the LABEL control. A text is
written to the MSG register by calling the following
EzCore API:

SET_MSG(WORD MSGno, TCHAR UMSG[301);

MSGno — MSG register number
UMSG[30] — Unicode message string

Example:
SET_MSG(100, L"# Overvoltage™);

This function call writes the text message “# Overvoltage”
to the MSG register at index 100. As the message starts
with the “#” character the LABEL mapped to the MSG
register 100 will blink at the interval set at “Alarm Timer 0,
1,2.”
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434 EzHMI ColorEdit

4.3.4.1 Description

The main task of the ColorEdit control is to enable the user to write values or strings to
mapped register. When used as data entry, the data can be validated on entry to check for
minimum and maximum values. The entered value is then only accepted if the value lies
within the set limits.

At runtime a ColorEdit box
— writes values (float, integer) to and reads values from the assigned register (AO,
D, F),
— writes a text strings of maximum 30 unicode characters to the assigned register
(MSG) and reads strings from the register,
— displays a virtual keyboard for keying characters or values via touch screen.

Setting:
In the following the configuration interface of the ColorEdit control will be discussed in
more details:

Appearance Styles: Register Type and Number Assignment:
i : DT_CENTER v -
}Ahgn Test = ‘Select Input MSG/AQ/D/E Register MSG
‘ ColorEdit --> MSG/AD/D/Fno 00000000
Color:
‘Upper Limit: 1000000000
‘Back Color: ‘
‘Luwer Limit: -1000000000

Control Status:

Mno(On) > Disable ActiveX 00000000

Refresh Interval (Unit 50ms):

‘Flash Timer 0,1.2..... 00000002
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4.3.4.2 Flash Timer

Refresh Interval {Unit 50ms):

‘Flash Timer0,1,2..... 00000002

The ColorEdit control flash timer has basically two tasks:
1. ColorEdit input has been changed: Update the corresponding register to
the new input.
2. Register has been changed: Display the new register content.

The flash timer writes to and reads from the assigned ColorEdit register at the set
time interval. The unit of the flash timer is 50 milliseconds. A flash timer value of
two will update the ColorEdit display and register status every 100 milliseconds.

If the flash timer setting is zero, the ColorEdit control will not be updated during the
program execution time. To ensure that the ColorEdit control and the register are
updated in regular intervals an integer number greater than 0 has to be entered.

4343 Register assignment

A ColorEdit control writes to and reads from a register (MSG, AO, D, F). The
following steps describe the mapping procedure:

STEP 1: Select a proper register type for the control. Select from the combo box
“Select MSG, AO, D, F” the required register type.

STEP 2: Then enter in the “ColorEdit =» MSG, AO, D, Fno” a register number
according to the register table.

STEP 3: For the register types AO, D and F limit values can be set. If an entered
value exceeds the configured limit value the value is rejected.

Register Type and Number Assignment:

Select Input MSG/AQ/D/F Register MSG 3 —_—— > - -
Specification | Register Register numbers
it - 00000000
ColorEdit MSG/AD/D/Fno Ana[og Output AO e 0 ~511
‘Upper Limit: 1000000000
| T D Mone Retain: 1 ~3599
‘aner Limit: -1000000000 ong/integer Retain. 2096 ~ 7999
None Retain: 1 ~1899
Control Status: Float F Retan 2048 -~ 3999
= Di f 00000000
|Mnu(0n) > Disable ActiveX Message MSG Retain: 1 ~249
P

55



The control can be disabled by assigning “Mno(on) »Disable ActiveX” a register number
and setting this register to true either by using a EzZHMI SWITCH control or by calling

the EzCore API:
= SET M (WORD Mno, bool Flag);

This prevents the user from entering any value or character to the ColorEdit box.

4.3.4.4 Virtual Keyboard

The virtual keyboard is an on-screen keyboard and can usually be operated with multiple
input devices, such as the actual keyboard, a computer mouse and a touch screen. Two
types of virtual keyboards are provided: a number keyboard and a character keyboard.

To enable the virtual keyboards the M8000 Register has to be set to true by either calling
the EzCore API
= SET M (8000, true);

or by using the EzZHMI SWITCH control.
If the MSG has been selected as register type for the ColorEdit control the character

keyboard pops up when the control receives the focus. A selection of AO, D or F register
type causes the number keyboard to appear as soon as the control is activated by the user.

Number Keyin
< 40
> -40

7 8 9

4 5 6

1 2 3
Cancel Clr OK

Number keyboard
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1| 2 4 9 | -
=7 q w r 0 ] |
d d f k I E 1 |
hift . ) ! ;
oK
Space Cancel Clr |

Character keyboard
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4.3.5 EzHMI ButtonST

4.3.5.1 Description

The ButtonST control sets the flag of its assigned M register to true. It only writes data to
the M register. An event is triggered when you click the button. C code has to be
implemented to process the event.

The button sets the flag to true
— after it has been clicked or
— after it has been released or
— while it is being pressed (useful for jogging)

The ButtonST control supports the following layouts:
— Button with multilingual caption: The caption should describe the type of event
being triggered by the button click.
— Button with graphic: The button can be provided with two bitmaps, one for
indicating an enabled and the other for displaying a disabled button. The graphic
shown on the button gives information regarding the status of the button.

Setting:
In the following the configuration interface of the ButtonST control will be discussed in
more details:

Appearance Styles: Multi-Language Caption:
Select Enable/Disable BMP |Ca|:|ti|:|n: Language 0. 3
|BMP Directory (Enable): SetBMP... 0. |Caption0 1. Caption1
|BMP Directory (Disable): Set BMP... 2 Caption2 3 Caption3
|BMP Style: Image-=FULL 3 4 Captiond 5 Caption5
|BMP Position: Button->LEFT 3 g |Captiond ;. Caption?
|Bnun|:|ery Offset: 2 Register Type and Number Assignment:
Color: ‘Buttun(DDwn) --> Mno(On) 00000000
|Back Color: _ ‘Buttun(Duwn;’Up) --> Mno{On/Off) 00000000
[Font Color: | Button(Up) --> Mno(On) 00000000
Control Status:
Mna(On) --> Disable ActiveX 00000000
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4.3.5.2 ButtonST Appearances

A ButtonST can have an image, caption and boundary on its surface.

The following display styles are being supported by the ButtonST control:
— FULL: The button surface area is filled with the attached image.
— HALF: Half of the button surface is filled with the image. The
position of the image on the surface can be set:
= LEFT
= TOP
— QUADRATE: The image will be displayed in a square. The
position of the square on the button surface have to selected:
= LEFT
= TOP
— BMP Offset: provides a button boundary. Boundary width is
measures in pixels.

Image->FULL
‘BMP Style: Image->HALF =7 Image->HALF
: Image->QUADRATE
‘BMP Position: Button->LEFT & ——
Button->TOP

Image->FULL

-,
Image->HALF 'J.Qlj Valve 2

-,
V.

-,
Image->QUADRATE IJIQ'J valve 2 Il!"

Button-=LEFT Button-=TOP
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4.3.5.3 Caption

Each ButtonST support caption text in 8 different languages. During runtime the
caption text can be changed to a different language. To display a caption on the
ButtonST
— Type for each text box (0. to 7.) the caption text in a different language.
Each text box represents a different language.
— Set the caption text font and size by clicking the “Fonts” tab

— Set the text and background color by clicking the color button next to
“Back Color” and “Font Color”.

— Selected from the language combo box (Language 0., Langauge 1., etc)
the default language text (0 to 7) to be displayed.

Multi-Language Caption:

Caption: Language 0. v
0. Valve2 1 B2

o, M2 g JULT 2

4. Ventil 2 5 Valula 2

6. Valve 2 7. Valvula 2

= = = NN ==
(- BB R

=0 . A
U O L) - -

4.3.54 Bitmap Attachment

Each ButtonST control can be enabled and disabled during runtime. For each status a
different bitmap can be attached to the button.

Procedure to load a bitmap into a ButtonST:
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Appearance Styles:
Select Enable/Disable BMP

‘BMP Directory (Enable):
‘BMP Directory (Disable):
‘BMP Style: Image->FULL v

‘BMP Paosition: Button->LEFT v

Boundery Offset: 2

STEP 1: Create a bitmap picture with a graphic program and save it as a .bmp file.

STEP 2: Load the bitmap file to the ButtonST by clicking the “Set BMP ” button
and selecting the desired image. Make sure that the data format of the
bitmap is .omp.

STEP 3: Copy the bitmap file to the following directory on the WinCon or MPac:

— for WinCon: “\CompactFlash\EzProg-NEzHMN\BMP”
— for MPac: “\System_Disk\EzProg-NEzHMI\BMP”

4.3.5.5 Register assignment

Each button control can be linked to three different M register numbers.

Register Type and Number Assignment:

‘Buttun(Duwn) --> Mno(On) N

‘Buttun(DuwnfUp) --> Mno{QOn/Off) 40

‘Buttun(Up) = Mno(On) 42

Control Status:

Mno(On) -—> Disable ActiveX 00000000

1. “Button(Down)=>Mno(on)”: Clicking the button sets the assigned register to

true.

“Button(Up) 2?Mno(on)”: Releasing the button sets the linked register to true.

3. “Button(DownUp) ->Mno(on/off)”: Clicking and keeping the button down
sets the linked register to true. As soon as the button is being released the
register will be set to false.

no
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For “Button(Down) *Mno(on)” and “Button(Up) *Mno(on)” register the flag can only
be set to true by the control. The register has to be reset either by using the EzZHMI
SWITCH control or true by either calling the SET_M() API.

The following code, which can be implemented in the UserThread, RTSR or ISR, shows
how the change of a register status (here button down action is attached to M register 41)
can trigger an event and how to reset the status:

if( GET_Ma(41))
{

//implement here your event code
//- .

//Reset the the status of register M41
SET_M(41,false);

}

Each ButtonST supports two states during runtime: enabled and disabled. An enabled
button can be activated (clicked) while a disable button allows no user input. Assign the
button a M register number by entering a value for “Mno(on) = Disable ActiveX”. This
register number determines the status of the button. A true enables and a false disables
the button. The status of the register has to be set either by using a EzHMI control (e.g.
SWITCH) or by calling the SET_M() API.
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4.3.6 EzHMI Image Control

4.3.6.1 Description

The Image control allows the insertion of a bitmap image to the user interface. The image
can be a background image representing a plant or control system. Other controls like
LED and switches can be placed on top of the image. The Image control can also be
configured in such a way that it move across the user interface to a target position during
runtime. Furthermore the Image control can handle click events. C code has to be
implemented to process the event.

The Image control supports the following properties:
— Adding a bitmap Image to the user interface
— Replacing images during runtime
— Moving the images during runtime
— Clicking events

Setting:
In the following the configuration interface of the Image control will be discussed in
more details:
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Appearance Styles:
BMP Directory: File ...

Register Type and Number Assignment:

Dynamic Change Image:

Dno --> Change BMP (PICsoocx.bmp) 00000000

Mno{QOn) --> Active Change 00000000

Image Position(Left and Top):

Input X{Dno), Y(Dno+1) --> Move to (X, Y) 00000000
Click Down/Up -->= Mno({On/Off) 00000000
Click Down --> Mno(On) 00000000
Click Up --> Mno{On) 00000000

Control Status:

Mno --> Hide ActiveX 00000000

4.3.6.2 Bitmap Attachment

4.3.6.2.1 Adding Default Image

A default bitmap image is an image shown on the user interface directly after program
start.

The following procedure describes the loading of a default bitmap:

Appearance Styles:

|BMP Directory: File ...

STEP 1: Create a bitmap picture with a graphic program and save it as a .bmp file.
(Notice: WinCon supports only a color depth of 16 bits)
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STEP 2: Load the bitmap file to the Image control by clicking the “File... ” button
and selecting the desired image. Make sure that the data format of the
bitmap is .omp.

If you do not want to display at program start, just leave the “BMP
Directory: ” empty.

STEP 3: Upload the bitmap file to the following directory on the WinCon or MPac:
— for WinCon: “\CompactFlash\EzProg-\EzZHMI\BMP”
— for MPac: “\System_Disk\EzProg-\EzZHMI\BMP”

Notice:

If you want to add a control (e.g. SWITCH, EzKnob, LED, etc) on top of the image make
sure that the tab order number of the added control is lower than the Image control. To
view and alter the tab order number in VS2008, click Format -*Tab Order. The tab
number for each control is displayed in a blue box. Change a number of a control by
clicking on it. Click the Image control representing the background after all the other
controls have been clicked. The Image control will show the highest tab number.

The following figure shows four controls with their respective tab numbers. Three
EzHMI Label controls with the numbers 1, 2, and 3 and an Image control with the tab
number 4. Image control displays a tank, combustion chamber and inlet and outlet valves.
The Image control forms the background and therefore is set to the highest tab number 4.

Format | Tools Test Window He

Align >

Space Evenly [ 3

Make Same Size [ 3

Arrange Buttons 3

Center in Dialog [ 3

Auto Size [ 3

Flip 1'._Jl_lt|E!t Walve
Tab Order Cirl+D

Guide Settings...

@ Toggle Guides Cirl+G
@7 Check Mnemonics  Cirl+M
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4.3.6.2.2 Changing Image at Runtime

A default bitmap image can be replaced during runtime by another image.

The following steps demonstrate the procedure:

Dynamic Change Image:

Dno --> Change BMP (PICxo00x.bmp) 3000

Mno(On) --> Active Change

Image Position(Left and Top):

Input X(Dno), Y(Dno+1) --> Move to (X, Y) 00000000

STEP 1:

STEP 2:

Create one or more bitmap pictures and save them as .bmp files by using
the following filename convention: PICxxx.bmp
The filename should always start with PIC
Enter for xxx any number in the range from 1 to 2147483647
Examples:
— PIC1.bmp
— PIC10.bmp
— PIC1356.bmp
(Notice: WinCon supports only a color depth of 16 bits)

Download the bitmap files to the following directory on the WinCon or
MPac:

for WinCon: “\CompactFlash\EzProg-I\EzHMI\BMP”

for MPac: “\System_Disk\EzProg-\EzHMI\BMP”

STEP 3: Assign “Dno->Change BMP(PICxxx.bmp)” a D register number. This

register determines which picture is going to be displayed on the Image
control.

Dno -> Change BMP (PICxocx.bmp) 3000 *
Specification | Register Register\numbers
| int D Mone Retain: 1 ~ 3599
ong integer Retain: 4096 ~ 7999
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STEP 4:

STEP 5:

The number indicated by xxx in STEP 1: have to be written to the D
register number. The register value can be changed either
programmatically (UserThread, RTSR, ISR) or by using an EzHMI
control (e.g. ColorEdit control).

Examples:

In this example it is assumed register number 3000 has been mapped to
“Dno->Change BMP(PICxxx.bmp) ”. The register value is changed by
calling the API SET_D():

— PICL.bmp - SET_D(3000, 1);
— PIC10.bmp - SET_D(3000, 10);
—  PIC1356.bmp > SET_D(3000, 1356);

Assign “Mno(On) =*Active Change” a M register number. If this register
changes its value from false to true the control displays the image assigned
to the D register number in STEP 3:. The Image control sets the M flag
automatically back to false after updating the image.

Mnoon) > Active Chang 1 . Specification | Register Re%ister numbers

None Retain: 1 ~6999

Flag M Retwm | 8192~ 15999

Implement the code for changing the image.

In the following example the “Dno-=>Change BMP(PICxxx.bmp)” has
been mapped to D register number 3000 and “Mno(on) >Active Change”
to M register number 1.

Alternative 1:
Add the following code to the UserThread, RTSR or ISR:

//Assign image PIC1356 to D register 3000:
SET_D(3000, 1356);

//Inform the Image control to display PIC1356
// by setting the M register 1 to true
SET_M(1, true);

Alternative 2:
Add a SWITCH and a ColorEdit control to the dialog.
— Set the SWITCH control properties as shown in the following
figure:
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Register Type and Number Assignment:

¥/M Enable

Select Y/M Register M v
| Switch(On/Off) - Y/Mno 1
Mno(On) --> Lamp 00000000

Control Status:

Mno(On) --> Disable ActiveX 00000000

Refresh Interval (Unit 50ms):
Flash Timer0,12..... 2

— Set the ColorEdit control properties as follows:

Register Type and Number Assignment:

‘Select Input MSG/AD/D/F Register D v

‘CulurEdit --> MSG/AQ/D/Fno 3000

Refresh Interval (Unit 50ms):

‘Flash Timer 0,12.... 2

At runtime the user can enter a valid picture number in the ColorEdit box.
After setting the SWITCH to true the Image control will be updated with
the selected image.

4.3.6.2.3 Changing the Image position at runtime

During runtime the position of the Image control can be changed. In this case the control
can represent a moving object (e.g. assembly line) on the screen.
The following steps are required:

STEP 1: Add an image to the control as described in the previous two section

STEP 2: Select two D register for storing the image x and y position. Only the
register number for the x position has to be entered. The number following
X register number is automatically assigned to the y position. Therefore
you have to make sure that this number is not being reserved for a
different purpose.
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STEP 3:

STEP 4:

Image Position{Left and Top}:

Input X(Dno), ¥{Dno+1) --> Move to (X, Y) 4 *
Specification | Register Registel\numbers
lona integer D None Retain: 1 ~3599

g integ Retain 4096 ~ 7999

Assign “Mno(on) 2Active Change” a M register number. If this register
changes its value from false to true the control reads the target position
and moves to the new position. The Image control sets the M flag
automatically back to false after the reading operation has finished.

Mno({On) --> Active Change 1 k
Specification | Register Registef\numbers
None Retain; 1 ~6999
Flag M Retain 8192 ~ 15999

Implement the code for changing the image position. In the following
example “InputX(Dno),Y(Dno+1) >Move to(X,Y)” has been mapped to D
register number 4 and “Mno(on) 2>Active Change” to M register number
1.

The control uses a coordinate system similar to the Cartesian's but the
origin is located on the top left corner of the dialog box. Using this
coordinate system, any point can be located by its distance (unit = pixel)
from the top left corner of the dialog box.

‘Qﬂ\; X %
_ MyTemplate : m
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Alternative 1:
Add the following code to the UserThread, RTSR or ISR:

//New image position:
// x-axis:

SET_D(4, 15); // x
// y-axis:

SET_D(5, 20); // y = 20

15

//Inform the Image control that the position has been
// changed:
SET M(1, true);

Alternative 2:
Add a SWITCH and two ColorEdit control to the dialog.
— Set the SWITCH control properties as shown in the following
figure:

Register Type and Number Assignment:

¥/M Enable

Select Y/M Register M v
| Switch(On/Off) - Y/Mno 1
Mno(On) --> Lamp 00000000

Control Status:

Mno(On) --> Disable ActiveX 00000000

Refresh Interval (Unit 50ms):
Flash Timer0,12..... 2

— Set the ColorEdit control properties for the X- axis as follows:

Register Type and Number Assignment:

‘Select Input MSG/AQ/D/F Register D v

‘CulurEdit --> MSG/AQ/D/Fno 4

Refresh Interval (Unit 50ms):

|Flash Timer01.2.... 2

— Set the ColorEdit control properties for the Y- axis as follows:
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Register Type and Number Assignment:

‘Select Input MSG/AQ/D/F Register D v

‘Cnlandit --> MSG/AD/D/Fno 5

Refresh Interval {Unit 50ms}):

|Flash Timer0,12.... 2

At runtime the user can change the position of the image by entering
values for the x- and y-axis in the ColorEdit boxes. Set the SWITCH to
true in order to move the Image control to the new position.

4.3.6.3 Events

The Image control generates three types of events. To make use of an event assign it to an
M register numbers.

Click Down/Up --> Mno{Qn/Off) 00000000
Click Down --> Mno{On) 00000000
00000000

Click Up --> Mno{On}

1. “Click Down->Mno(On)”: Clicking the image sets the assigned register to
true.

2. “Click Up22Mno(On)”: Releasing the button after clicking the image sets the
linked register to true.

3. “Click Down/Up -2Mno(On/Off)”: Clicking the image and keeping the button
down sets the linked register to true. The register will be set to false as soon as
the button is being released.

Click Down/Up > Mno(On/Off) 00000000

Click Down --> Mno(On) Y

Click Up --> Mno(On) LILTTe LY
Specification | Register Registeknumbers
Flag M EZ?jfm 819; . :;2339
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The flag for the “Click Down Mno(On)” and the “Click Up 2Mno(On)” registers set
to true by the control itself. The register has to be reset to false either by using an EzHMI
SWITCH control or by calling the SET_M() API.

Example:

The following code, which can be implemented in the UserThread, RTSR or ISR, shows
how to use a flag generated by a click event. It is important to reset the flag to false in
order to catch the next click event.

if( GET_Ma(50))
{

//implement here your event code
//. ..

//Reset the the status of register M41
SET_M(50,false);
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4.3.7 EzHMI ColorCheck

4.3.7.1 Description

The ColorCheck control is associated to a group of 8 check boxes. The checkbox group
appears on a separate window form when the ColorCheck control is being clicked. None,
one or more checkboxes may be checked by the user according to the information they
wish to send with the form. A checkbox indicates whether a particular item is selected or
not. A checkbox can also be used as a switch to present a on/off , open /closed or
true/false status to the user.

[ Valve 1 [ Valve 5
[ Valve 2 [ Valve 6
[ Valve 3 [ Valve 7
[ Valve 4 [ Valve 8
oK Cancel

The ColorCheck control supports the following properties:
— Multi-Language selection
— Selection of one or more options from a set of alternatives
— Selection change notification

Setting:
In the following the configuration interface of the ColorCheck control will be discussed
in more details:
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= A
Multi-Language Caption

0 ‘Cap‘ﬂono | ‘Cap‘ﬂom 2 |Caption2 3 |Caption3 4 |Captiond 5 |Captions 8 |Caption6 7 |Caption?
List Items:
. |0.Itemd 1|0 1tem 2 |0 tem2 3.|0.Item3 4|0 Itemd 5 |0.ItemS 6.|0.1temb 7|0 Item?
0 1.Item0 1 1.Item 2 1.ltem2 3 1.Itern3 4 1.Itemn4 5 1.ItemnS &.|1.1temB 7|1.Item¥
J ! d ? 4 g | i
0 1 2 3 4 5 6 7
0 1 2 3 4 5 6 7
d ! ? | ! d ° )
o ! 2 2 4 g ° "
o ! d 2 4 d | i
Color: Register Type and Number Assignment:
Back Color _ |ChecK Chang --> Mno(Qn) |OOOOOOOO
W ‘ |Check Select—» Brno |OOOOOOOO
Conitrol Status:
|Mn0(0n) --> Disable ActiveX |00000000

4.3.7.2 Caption

4.3.7.2.1 ColorCheck Caption

The purpose of the caption is to act as a header for the item list to enable the user to
identify the list more easily. As with most EzZHMI ActiveX the ColorCheck supports
caption text in 8 different languages. In the control property sheet each text box (0. to
7.) represents a different language. During runtime the caption text can be changed to
a different language. To display a caption on the ColorCheck:
— Replace the default caption text (Caption0, Captionl, ...). Each textbox
represents a different language.
— Set the caption text font and size by clicking the “Fonts” tab
— Set the text and background color by clicking the color button next to
“Back Color” and “Font Color”.
— Selected from the language combo box (Language 0., Language 1., etc.)
the default language (0 to 7).

Multi-Language Caption:

Language 0. =

0 ‘Valve 1 ‘Fﬁf‘ﬁ 3 ‘F&I\“J 3

L7 4 |\/enti\ 5 |\/é\vu\a & |\/a\ve 7 ‘\/élvula
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4.3.7.2.2 Checkbox Caption

The ColorCheck dialog window displays 8 checkboxes. Each checkbox has to be
provided with a caption. A checkbox with no caption will automatically be disabled
and the user can not enable or check it during runtime. Multilanguage support for
checkbox caption is provided. Each column in the “List Items” group represents the
caption text of the checkboxes in a different language. A column consists of eight
textboxes each storing the text for the eight checkbox caption. It is not possible to
change the color, font or size of the checkbox caption text.

Multilanguage

>

! ! H ! ! ! 1
Languege® | Language1 | Language2 | Language3 | Languaged | Language5 Language§ | Language7
Checkbox 0: 0 [vatve 1 i 1 |N_ﬂ 1 : rz "uf;'['] 1 “taf . 4 [verti 1 1 L\ I\-‘n.‘.-- 1 .Ejr [Varta
s Checkbox 1: {0 Y32 L LE 2|mr2
: - e .: et .
% Checkbox 2: {g[¥aves 1 |N'1 <
(8] I e i
x| Checkboxs: 0 Valygd 114
o S Vatve 5 i 5
= Checkboxd: |0 ave i !M*'
] sl :
a | s | —
= Checkboxg: 1038 SICLE
(8] EREE RN, 4ie) ! }
Checkbox 6: .0 i !HH 7 2|7 laf s 77 tqfVenti 7
""""""" N LE IACRE 1a[7e {4 [Venti s
£ | i H i

¥ CheckboxT: , 0

In the following figure only the first six of the eight checkboxes are assigned a
caption text. Therefore on the checkbox group window the checkboxes provided with
a name are enabled and can receive use input the others are disabled.

List [tems:
o [valve 1
o|valve 2 [ Valve 1 [ Valve 5
o|varve 3 [ Valve 2 [ Valve 6
q[valve 4 = || [ Valve 3 O
q[valve 5 [ Valve 4 O
o [Valve B oK Cancel
0
0
4.3.7.3 Register assignment

75



The checkboxes within the group are sequentially numbered starting from zero. The
statuses of the eight checkboxes are written to the linked BYTE register. The least
significant bit represents the status of the first checkbox in the group, bit 1 represents the
second checkbox and so forth. Enabling/disabling one or more checkboxes writes the
new status to the mapped B register.

Register Type and Number Assignment:

Check Change --> Mno(On) 00000000

Check Select --> Bno 00000000

Control Status:

Mno{On) --> Disable ActiveX 00000000

The checkbox status is linked to a register by entering for “Check Select-> Bno” a B
register number.

Furthermore it is possible to indicate with a notification flag that changes were made to
the ColorCheck by the user. Assign “Check Change = Mno(On)” to a M register
number. Every time the user changes a checkbox status this register will be set to true
after the checkbox group window has been closed.

Register Type and Number Assignment:

Check Change --> Mno{QOn)

Check Select --> Bno

Control Status:

Mno(On) --> Disable ActiveX

000*000

| Specification | Register | Register numbers\
NoneReta\u 1 ~6999
Flag i Retain__\ 8192~ 15999
A
MNone Retain: 1 ~699
BYTE B Retain: 1024 ~ 2047

The following code snippet, which can be implemented in the UserThread, RTSR or ISR,
shows how to read the ColorCheck status. The notification flag “Check Change =

Mno(On)” is mapped to M register 111 and the ColorCheck status “Check Select >
Bno” to B register 1.
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bool bCheckBox[8];

// STEP 1: Check whether the ColorCheck control status has changed

if (GET_Ma(l1l)== true)

{

Example:
The ColorCheck status “Check Select=> Bno” is linked to B register 1.
The following function call unchecks all the checkboxes.

// STEP 2: Read the status of each checkbox
for(int i1=0; i< 8; i++)

bCheckBox[1] = GET_B(1) & (1<< i1);
}

// STEP 3: Reset the notification flag to false
SET_M(111, false);

// STEP 4:
//Implement code to handle the new setting

//1f checkbox O is checked
if(bCheckBox[0]== true)
{

// add your code
}

//1f checkbox 1 is checked
if(bCheckBox[1]== true)

// add your code

The status of the ColorCheck can not only be changed via the graphic interface but also
by directly changing the value of the assigned B register number in the program. Use the
following function:

SET_B(WORD Bno,BYTE Val);

The only way to set the checkbox group to a default selection at program start is by
calling the SET_B() function in the MFC OnInitDialog() function.

SET _B(1,0);
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4.3.8 EzHMI ColorRadio

4.3.8.1 Description

The ColorRadio control represents a group of 10 radio buttons which appears on a
separate window form when the ColorRadio control has been clicked. Radio buttons
work just like checkboxes except that they are mutually exclusive to one another. When
the operator selects an option, any previously selected option in the same group becomes
deselected. A ColorRadio control therefore allows only one single item out of the group
to be selected.

By default one option is selected, even if the user has not made any input.

@ Valve 1 I Valve 6
@ Valve 2 O Valve 7
(9 Valve 3 (DValve 8
O Valve 4 O Valve 9
(D Valve 5 Valve 10

Figure 8: ColorRadio window

The ColorCheck control supports the following properties:
— Multi-Language selection
— Selection of one options from a set of alternatives
— Selection change notification

Setting:
In the following the configuration interface of the ColorRadio control will be discussed in
more details:

4.3.8.2 Caption

Each radio button on the radio window needs to be provided with a caption name. A
radio button without a name will be shown as a disabled button and is not available for
user input. The name of the selected option button will be shown automatically on
ColorRadio control.
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Ok} ]|

ColorRadio button

@ Valve 1 @ Valve 6
(3 Valve 2 I Valve 7
@ Radio Buttons  vave 8
(9 Valve 4 (D Valve 9
3 Valve 5 O Valve 10

The Radio button names have to be entered in the items list. Each column in the “List
Items” group represents the caption name of the radio button in a different language.
A column consists of ten edit boxes each storing the name of the respective radio
button.

Multilanguage _

____________ : Language 0 { Language 1 E Language 2 E Language 3 :I Lang 4 I' Language & |: Language & i Language 7
" Radio Bution 0: io:"""""‘ E, |=g|-11 iz ||i£|“|1 i 3 [o i‘, |'v'9!.|||1 E.; |'V'a'}-1.|la 1 is i\r"dh‘e 1 i7 |\-"ah'ulal
£ Radio Bulter 1: 50:-”-,»\@3 E, |=gr'1'_' i2 ||i£|“| 2 i3 |:'\',|, 72 i1 iv-_-..m 2 E.; |'v'é}-1.|la 2 EG i\r"dNe 2 i? |\o"alvula'_‘
E Radio Button 2: ::0:\.-'5'\».» 3 E; |=:r'1 3 é: |IiEI"I 3 i 3 |:'\',|, 73 il‘, iv-_-..m 3 E.; |'v'é}-1.|la 3 EG i\r"dh‘e 3 i? |\-"alvula'4'
g Radio Button 3: Eo:x-'sm» ] E; |=:r'1 4 iz |IiEI"I 4 i 3 |:'\',|, 74 i‘, iv-_-..m 4 E.; |'V'a'}-1.|la ] EG i\mwE ] i? |\"ah'ula-1
E Rédio Butiond: ':0:-”-,»\@-; E, |=gr'15 iz ||i£|“| 5 : 3 |:'\',|, 75 i iv—.-..m 5 E.; |'v'é}-1.|la 5 EG i\r"dh‘e 5 i? |\-"alvula‘:
5'-; S hiE 'iO:.L.-,wu E, |=gna éz |u§.-'| 6 i 3 |:'\',|, =6 il‘, iv—.-..m & E's |-\,-;}-1.|Ia 6 EG i\r"dNe 3 E? |\_.-ah'ulatf
= Radio Buttong. 0|37 1 E; [r17 2 |IiE|"I i3 [ra77 i‘, [enti7 Is [vétnsaT is i\r"dNe 7 i7 |\o"alvula 7
= S Eranns) ':OZ-L-',M»;; i LB i [Rr18 la[oL7s 14, [Veniis i5[Vania is [vates i [Vt 8

¥ hac ot lo[Vaie E, |=g|-1<4 i: |li£|“|‘-‘ i 3 |:;-,|, =T i.d iv-.-..mg is |-V-;}-1.|Ia 9 EG i\r"dh‘e 4 i? |\_.-ah'ula\.l
BT .;0:'...'5'\’\.*1(\ E,|=gmu iz ||i£|“|w §3|1'\';L')'1C- i‘, iv—.-..nnu E.; |Eﬁ\ .EG i\r"dh‘e 10 i? |\o"alvula|0
------------ 4 ] i ] 1

It is possible to set the color, font and text size of the ColorRadio button but this
setting can not be done for the buttons on the ColorRadio window.

Altering the appearance of the ColorRadio button:
— Set the caption text font and size by clicking the “Fonts” tab
— Set the text and background color by clicking the “Back Color” and “Font
Color” buttons.
— Selected from the language combo box (Language 0., Language 1., etc.)
the default language text (0 to 7).

The following figure shows how to disable a radio button by simply not entering a
name for the respective radio button. The first three radio buttons have a caption text.
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Therefore the ColorRadio window shows only three enabled radio button with names
and the others are disabled. The unused buttons can not be removed from the window.

List Hems:

ofvalve 1
ofvees @ Valve 1 @)
ofvalve 3 \
. © Valve 2 ®
0 ) Valve 3 @)
0

© ®
0
0 @) @)
0
0.

4.3.8.3 Register assignment

The ColorRadio window has to be mapped to a D register. This is done by entering for
“Radio Select= Dno” a valid D register number. The radio buttons on the ColorRadio
window are numbered from zero to nine. After selecting a radio button the number of this
button will be written to the assigned register. For example, when button 3 is selected the
register will store the number 3.

The default value of a radio button has to be set in the USER_INITIAL()function in the
A_Template.ccp file of the EzTemplate.

Register Type and Number Assignment:

‘Radiu Change --> Mno{On) 222

‘Radiu Select --> Dno 2

Control Status::

[Mno(On) --> Disable ActiveX 00000000

Example: The “Radio Select> Dno” is linked to D Register 2. The radio button no. 7 is
chosen to be the default selected button; therefore it is required to write the value 7 to the
register.

void USER_INITIALQ
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// Add your initialisation code:
SET_D(C 2, 7);

Furthermore it is possible to indicate with a notification flag that changes were made to
the ColorRadio window by the user. Assign “Radio Change 2 Mno(On)”toa M
register number. Every time the user selects a different radio button, this register will be
set to true. The register have to be reset to false by calling SET_M(RegisterNo, false).

A ColorRadio is disabled by assigning “Mno(On) - Disable ActiveX” a M register
number and set this register to false by using the EzHMI SWITCH control or by calling
the SET_M() API in the program. A disabled ColorRadio does not process any user input.

The following code, which can be implemented in the UserThread, RTSR or ISR, shows
how to read the ColorRadio status. The notification flag “Check Change - Mno(On)” is
mapped to M register 222 and the radio button selection “Check Select= Dno” to B
register 2.

// STEP 1: Check whether a new radio button has beeen selected
if (GET_Ma(222)== true)
{

// STEP 2: Reset the notification flag to false
SET_M(222, false);

// STEP 3:
//1mplement code to handle the new setting

switch (GET_D(2))
{
case 0: //option button no O is selected
// add your code
break;

case 1: //option button no 1 is selected
// add your code
break;

case 2: //option button no 2 is selected

// add your code
break;
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4.3.9 EzHMI EzKnob

4.3.9.1 Description

The EzKnob visualizes data like pressure, temperature, volt, etc. in form off Multi-
Needle Gauge. The EzKnob object has two features:
= it displays the value of the source register in an intuitive way,
= manual input by dragging the needle (via mouse or touch screen) to the required
position automatically updates the destination register with the value of the
EzKnob.
The EzKnob is available in different graphic looks with a range of configurable
parameters in order to be customized according designer's needs. Text regions on the dial
face can show tick value, units and scale multiplier. The color of each part of the dial is
configurable. If the EzKnob source register is connected to an AlO channel, the dial will
automatically move its needle to match the value of the channel with no need for any
application code.

Knob 1 Knob 2 Knob 3

Setting:
In the following the configuration interface of the EzKnob control will be discussed in
more details:

4.3.9.2 Appearances

1. Styles:
= Knob1
= Knob 2
= Knob3
2. Frame:

Select between EzKnob with or without a frame
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3. Tick configuration:
The configuration allows two different sized ticks (major and minor ticks) to
be placed at regular intervals along the Scale. The control allows the
following ticks settings:
= Number of ticks
= Tick color
= Tick minimum and maximum value

4. EzKnob color:
Each component of the dial may have a different color:
= Indicator or needle

Track

Scale text

dial background

Tick label

Tick unit label

Scale factor label

5. Label text font and position:
The text font and position of the following labels can be set:
= Tick label
= Tick unit label
= Scale factor label

4.3.9.3 Register assignment

The EzKnob object can be set to one of the following mode at a time:
= Only read and display register data.
= Write data to a register by letting the user change the needle or indicator
position and reading data from the register.

4.3.9.3.1 Display register data
The EzKnob control is able to display data from an Al, AO, D or F register type.

STEP 1: Select “Output” as the control type to put the control into read mode.
Appearance Styles:

Frame Show

|Cnntru| Type: Qutput v

STEP 2: Select a register type from the “Select Input AI/AO/D/Fno” combo box
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Link the control to the selected register type by entering a number for
“Al/AO/D/Fno Knob Value”.

Output Type
Select Output Al/AO/D/F Register D v
|AIfAO,-'Danu --> Knob Value / 00000000
Specification | Register Register numbers
Analog Output AO Local AO: 0 ~51
Analog Input Al Local Al 0 ~5M1
lond inteder D None Retain: 1 ~ 3599
g g Retain: 4096 ~ 7999
Mone Retain: 1 ~1899
et F Retain 2048~ 3999

STEP 3: Enter a refresh time interval value for the “Flash Timer 0, 1, 2,..”. This
enables the EzKnob to read the assigned register and update the display to
the current reading at the set time interval.

STEP 4: Flashing alarm: Alarm occurs when the range limits of the control has been
exceeded. In an event of an alarm the background of the control starts to
flash. The following settings are required:

i.  Specify the upper and lower limit
ii.  Define the flashing frequency (“Alarm Timer 0,1,2...”). The
value must be greater than zero otherwise the alarm is disabled.

Input Limited or Alarm Level of Qutput

|U|J|:|er Limit: 3

|L|:|wer Limit 1

Refresh Interval (Unit 50ms):

Alarm Timer 0,1,2... 2

Flash Timer 0,12... 2
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4.3.9.3.2 Enter and display register data

The EzKnob control is able to write data to and read data from an AO, D or F register
type. By changing the position of the gauge needle the user can write data to the register.
In addition new register data are displayed by the gauge.

STEP 1: Select “Input” as the control type to put the control into read/write mode.

Appearance Styles:
Frame Show

|Cuntru| Type: Input v

STEP 2: Select a register type from the “Select Input AO/D/Fno” combo box
Link the control to the selected register type by entering a number for “Knob

Value>AO/D/Fno”.
Input Type
Select Input AO/D/F Register D v
Knob Value --> AO/D/Fno 1

Control Status:

|Mnu(0n) -->Disable Indicator 00000000

STEP 3: Enter a refresh time interval value for the “Flash Timer 0, 1, 2,..”. This
enables the EzKnob to read/write the assigned register and update the
display to the current reading at the set time interval.

STEP 4: Flashing alarm: To enable flashing when a range has been exceeded the
following settings are required:
i. Specify the upper and lower limit
ii. Define the flashing frequency (“Alarm Timer 0,1,2...”). The value
must be greater than zero otherwise the alarm is disabled.

STEP 5: The EzKnob can be disabled for user input during runtime. Enter a M

register number for “Mno(On) *Disable Indicator”. Setting this flag to true
during runtime will disable the control for user input.
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4.3.10 EzHMI EzSlider

4.3.10.1 Description

The EzSlider object offers two modes:
= Displays register values. The slider element will move up or down the scale to
show the value.
= Manual input capability by slider dragging (via mouse or touch screen). Each
change of the slider position immediately updates the destination register with the
slider value.

The EzSlider is available in different graphic looks with a range of configurable
parameters in order to be customized according designer's needs. Orientation can be
horizontal or vertical, with slider value increasing from bottom to top or from left to right.
This multi-purpose control has three different style options: Slider, linear gauge and
thermometer.

Slider Linear gauge Thermometer

Vertical

Horizontal

Setting:
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In the following the configuration interface of the EzSlider control will be discussed in
more details:

4.3.10.2 Appearances

1. Styles:
= Slider
= Linear Gauge
= Thermometer

2. Frame:
Select between a control with or without a frame.

3. Orientation
= VERTICAL
= HORIZONTAL

4. Tick configuration:
Two different tick types (major and minor ticks) are provided to be placed at
regular intervals along the Scale. The control allows the following ticks

settings:
=  Number of ticks
= Tick color

=  Tick minimum and maximum value

5. EzSlider color:
Each component of the control can be assigned a color:
= Indicator or pointer
= Scale track
= Slider background
= Tick label

6. Label text font:
The text font of the tick label labels can be set.

4.3.10.3 Register assignment

The slider supports two modes:
= |f configured to read a source register, the slider will move up or down the scale
to the position representing the value.
= |If a destination register is selected, that register will be updated with the value of
the slider. If the register value has been changed by another control or program
code the slider position will be updated to the new value.

88



4.3.10.3.1 Display source register data
The EzSlider control is able to display data from an Al, AO, D or F register type.

STEP 1: Select “Output” as the control type to put the control into read mode.

Appearance Styles:
Frame Show

|C|:|ntr|:|| Type: Qutput v

STEP 2: Select a register type from the “Output AI/AO/D/Fno” combo box
Link the control to the selected register type by entering a number for
“Al/AO/D/Fno 2Slider Value”.

Qutput Type:

| Output AI/AQ/D/Fno RegisterD v

Al/AD/D/Fno --> Slider Valuy 1

Specification | Register Regis?&( nhumbers
Analog Output AO Local AO; 0 ~51
Analog Input Al Local Al 0 ~5M
long integer D Eone_ Retan 1 = 3599
etain: 4096 ~ 7999
Float F Ez:jfetam 204; : ;ggg

STEP 3: Enter a control refresh time interval value for “Flash Timer 0, 1, 2,..”. This
enables the EzSlider to read the assigned register and update the display to
the current reading.

4.3.10.3.2 Change and display destination register data

If the EzSlider control is set to a read/write mode data can be written to or read from AO,
D or F register types. By changing with the mouse the slider position the associated
register will immediately be updated to the new value. If the register data is being
changed by the program or a different control the EzSlider object is automatically
updated with the new data.

STEP 1: Select “Intput” as the control type to put the control into read/write mode.
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STEP 2:

STEP 3:

STEP 4:

Appearance Styles:
Frame Show

|Cuntr|:|| Type: Input v

Select a register type from the “Select Input AO/D/Fno” combo box
Link the control to the selected register type by entering a number for
“Slider Value 22A0/D/Fno”.

Input Type:

|Mnu(0n) --»Disable Pointer 00000000

|Select Input AO/D/Fno Register D v

Slider Value - AO/D/Fno 1

Enter a refresh time interval value for the “Flash Timer 0, 1, 2,..”. This
enables the EzSlider to read the assigned register and update the display to
the current reading.

The slide bar can be disabled for user input during runtime. Enter a M
register number for “Mno(On) »Disable Pointer”. Setting this flag to true
during runtime disables the control for user input.
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4.3.11 EzHMI EzList

4.3.11.1 Description

The EzL.ist records messages and informs the user during operation. For example
information, warning, error and alarm messages are displayed by the list. The list consists
of three columns displaying the message together with the date and time of arrival. A list
can store up to 256 messages. The newest message is always added on top of the existing
list. Older messages will be overwritten when the number of messages exceeds the
available list rows. Each list is provided with a vertical scroll bars to scroll through the
messages.

The EzList has the following runtime functions:
— Output of messages (maximum 30 Unicode characters)
— Output of the date and time
— Delete EzList contents

The EzList is a passive control which only reads messages from the MSG register and
does not allow the user to do any direct editing. The MSG register itself however can be
changed for example through the ColorEdit or by using the SET_MSG( ) function.

channel 1 overvoffage
siot 1 is empfy
machine switched off

=

| 15:44:59 door locked
| 15:94:32 door closed
I 15:44:02 door open

L _Tv]

2]

|2£?£}'9 1007 15:42:36 valve I error
| 2009/16/07 15:42:20 vaive 1 closed
|2£?£?9 1007 15:42:00 valve 1 open

1)

Setting:
In the following the configuration interface of the EzL.ist control will be discussed in
more details:

4.3.11.2 Appearances

1. Styles:
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= Row with/without lines
= Row color

= Text color and size

= Background color

= Number of rows

Frame:
Select between a control with or without a frame

Time label:
= List with/without date label
= List with/without time label

4.3.11.3 Register assignment

Register Type

and Number Assignment:

‘Mm o Uyttt 1 | Specification | Register | Register numbers
None Retain: 1 ~6999

‘MSGnU > Ezlist: 1 Flag - Retain 8192 ~ 15999

‘Mnu > Clear All: 2 Message ‘ MSG ‘ Retsin 1 ~249

Automatic Add Date

Automatic Add Time

STEP 1:

STEP 2:

STEP 3:

STEP 4:

Assign a source MSG register number for “MSGno 2EzL.ist”. This register
contains the message to be displayed on the list

A flag is required to trigger an update of the list. Assign “Mno->Update” a
M register number. As soon as this register changes its status from false to
true the text in the MSG register will be added to the top of the list. After the
list has been updated the EzL.ist automatically resets the M register status to
false.

Assign “Mno ->Clear All” an M register number. Setting this register to true
will remove all text messages from the list. The EzList automatically resets
the M register status back to false.

Set the display refresh time (Flash Timer 0,1,2...).

Example:

In the following code the message “Hello World” is written to the list. “Mno22Update” is
assigned to M register 1 and “MSGno =EzL.ist” to MSG register 1.

//Step 1: Assign the MSG register number 1 the string “Hello World”:
SET_MSG(1, L”Hello World™);
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//Step 2: Add the string to the top of the list:
SET_M( 1, true);
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4.3.12 EzHMI Position

4.3.12.1 Description
The Position control is used for motion control applications. It can be set to display one
of the following motion parameters:
— Logic Position (LP)
— Encoder Position (EP)
— Velocity (CV)
— Acceleration (CA)

4.3.12.2 Configuration

Motion Card , Axis and Status

(CardNo (SlotNo): Card 1 v
Axis XAY[Z/U: Axis X v
Select LP/EP/CV/CA: LP v
Engineering: 000000000001
|Dec:ima| Puoint: 0

Register Type and Number Assignment:
Control Status:

Mno > Hide ActiveX 00000000

Refresh Interval {Unit 50ms):

Flash Timer 0,1... 00000001

STEP 1: Select the slot number of the motion control card.
STEP 2: Select an axis.
STEP 3: Determine which parameter to read:
i. Logic Position (LP)

ii. Encoder Position (EP)

iii. Velocity (CV)

iv. Acceleration (CA)
STEP 4: Enter the update rate.
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5 EzConfig Utility

5.1

Introduction

EzConfig is a utility to read, set and test the system configuration. The main task of the
utility is to detect the 10 modules in the PAC slots and map each input/output channel to
a register number of the corresponding register type. The programmer can access the 10
channels by directly reading or writing to their mapped registers. Four different 10
register types (X, Y, AO, Al) are provided: two for storing digital 10 values and two for
storing analog 10 values.

Specification | Register Register numbers Data type| Size Range
Egfizz] fnfp e - et 1003 :;;;7 o B
Digital Output v = 080 = 7177 o [ I
Analog Output AO Local AC: 0 ~511 float dbytes | 34E+-33
Analog Input Al Local Al 0 ~51 float dbytes | 34E+-38

Table S: 10 register types

The EzCore provides ¢ functions for accessing 10 registers:

Specification

Register

Read from Register

Write to Register

Digital Input

X

IN_Xa(X_RegisterNo);

Digital Output

Y

GET_Ya(Y_RegisterNo);

OUT_Y(Y_RegisterNo, Flag);

Analog Output

AO

GET_AO(AQ_RegisterNo);

OUT_AO(AO_RegisterNo, Value);

Analog Input

Al

IN_AI(A!_RegisterNo);

Table 6: APIs for accessing 1O registers

Note: It is very important to map all 10 channels to 10 registers with the EzConfig utility
before any other EzProg-1 program (or any other program using the EzCore library) can
be started. Changing the PAC module setup (e.g. adding new modules to the PAC,
plugging existing modules into different slots) requires a new 10 mapping by means of

the utility.
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5.2 Main properties

The utility has got the following main tasks:
— Slot configuration
— Module configuration
— Register mapping
— Reading input values and writing output values

Slot6 | Slot7 |

3

Figure 9: PAC before scanning its slots

Button Property

Scans every slot of the PAC for 10 modules. Once a module has been
@dsmuq detected and identified its image will be shown on the corresponding slot
= on the screen and its channels will be automatically mapped to a register
number of the respective 10 register.

Reads the previously saved PAC slot setting, module configurations and
10 register mapping. The slot settings are displayed by showing the image
of the PAC device itself with all the plug-in modules at the correct
position.

All the .NOT and .INI binary files in the EzConfig directory are read.

Saves the PAC slot settings (module names and their slot position),
module configurations and IO register mappings to the .NOT and .INI
binary files :
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Read

Edlit

ﬁ

Write

%

Fi%

—  Device.ini — noteDO.not

— noteAl.not — noteDW.not
—  noteAO.not —  noteF.not

—  noteB.not —  noteM.not
— noteC.not — noteT.not

—  noteD.not — noteW.not
— noteDIL.not

The EzCore engine uses these settings to update the 10 registers with the
correct input and output values.

Reads the value (“Val”) column and description (“NOTE”) column of the
I0_Table. XML file. The initial value of each register and the description of
the register are loaded.

Opens the user interface for entering the default or initial value and
description for each register.

Save the initial value settings and descriptions of all the registers to the
IO_Table. XML file.

Note: The EzCore engine is responsible for initializing and updating the
registers. The EzCore only accesses the configuration set in the .NOT

and .INI binary files and does NOT read the I0_Table.XML file. Therefore
it is necessary to save the initialization to the .NOT and .INI binary files by

button.

clicking the

Exit the EzConfig utility.

Table 7: EzConfig button description
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5.3 Slot scan and IO register mapping

STEP 1: Start the the EzConfig utility on the Windows CE platform:
Start Program -ICPDAS EzProg-1 EzConfig

| Communication  *

& [CPDAS » @ EzProgl (o
B cerdisp iids E250
#& cormand Prorpt & EzMake
W DCON_CE_WE00

il 3 isolwas
s '
4 REgView
= Documents * [3 TaskManager
[r Settings  * | B vs_2008_Connect

(=] £+ Windows Explarer
©/ KPAC_Utility

Figure 10: Start EzConfig utility

STEP 2: Click the “Scan Slot 1~7" button and confirm your decision by clicking “Yes” in
the message box.

Are you sure P
&l data wil cleared !

Figure 11: Start scan process

Every slot of the PAC will be scanned. Once a module has been detected and
identified it is displayed in the corresponding slot on the EzConfig drawing. At
the same time all the 10 channels of the modules are mapped to 10 register
numbers.
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Figure 12: Modules detected during the scan process

STEP 3: The 10 register mapping can be determined by clicking on a module. In addition
each module can be configured individually. For example the physical unit of the
analog input data (e.g. ampere, volt, and temperature) and the data range (e.g. -50
to 50mV, 4 to 20mA) of an analog input module have to be configured.

i-8017Hf i

\

Gain oe Gain oe Gain Moe Gain oe Ga|n Mode Galn Vode Galn oe Gain Mode
o lx] o vl [o vl [o vl [o ] o vl [o vl [o ]
Offset Offset Offset Offset Offset Offset Offset Offset
o o o o o o o o
Multiple Multiple Multiple Multiple Multiple Multiple Multiple Multiple
1 [1 [1 [1 [1 1 1 1
NOTE HOTE HOTE HOTE HOTE MOTE MOTE MOTE
J : : : : : : :
Input Yalue Input Yalue Input Yalue Input Yalue Input Yalue Input YWalue Input YWalue Input YWalue
o o o o o Io Io Io
q‘;}start "gIICPDAS EzConfig Tools For... |®*‘:lla SHEZL [ @lﬁ

Figure 13: Configuration interface of the i-8017H analog input module

STEP 4: Press “Save” to save the 10 register mapping.
STEP 5: Press “Exit” to close the program.

Note: It is necessary to close the EzConfig utility in order for other EzProg-I
programs to run smoothly.
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5.4 Module and channel configuration

The configuration page has the following purpose:
i.  Channel configuration
ii.  Channel description
iii.  Direct channel access: writing output, reading input

Only Modules which are plugged into the slots can be configured.

i.  Use the Scan ﬂ button to detect and display all plug-in modules.

After the slots have been scanned it is not allowed to change the slot
setting. That means it is not permitted to remove modules from a slot, add
new modules or change the modules slot position. This will cause an error.
Every change of the slot setting requires a new slot scan.

ii.  Click on the image of a module to open its configuration interface. Make
the necessary configuration and confirm the configuration setting by
clicking the “OK” button. Now click on the image of the next module
which needs to be configured.

iii. After all the modules have been set save the configuration by clicking the

button.

54.1 Digital input configuration

The configuration page of a digital input module displays for each input channel the
current status (ON/OFF), the assigned register type and register number. Digital input
channels can not and do not need to be configured, but it is possible to add a 30 character
comment next to each channel to describe its function in the control system.

Channel status:
— green color represent OFF
— red color represent ON

Example:

Click on the image of the DI module i-8040 in the first slot (see Figure 12). The i-8040
module has got 32 DI channels. The current status of each channel is displayed together
with the mapped register type (X) and register number.

Note: The register numbering for the X register type is based on the octal numeral system
(base-8 number system).

Octa: O 1 2 3 4 5 6 7 10 11 12 13 14 15 16 17 20 21
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Decimal: 0 1 2 3 4 § 6 7 8 9 10 11 12 13 14 15 16 17

In this example some DI channels LED are provided with a comment to specify their
purpose in the control system.

IREEEFLEERE
iehsessases. I

- §e § Each Dlicon displays its associated
green - OFF - register type: X

red -ON ; - register number

@ @

|® LBt 1130 am (] )

Figure 14: Configuration interface of the i-8040 digital input module
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54.2 Digital output configuration
The configuration page of a digital output module displays for each output channel the
current status (ON/OFF), the assigned register type (Y) and register number. Each
channel is represented by a switch which indicates the channel state. The state of a
channel can be directly changed by clicking the respective switch. A 30 character long
comment can be added to the text box next to each channel to describe its task in the
control system.

Channel status:
— green color represent OFF
— red color represent ON

Example:

Click on the image of the DO module i-8041 in the second slot (see Figure 12). The i-
8041 module has got 32 DO channels. The current state of each channel is displayed
together with the mapped register type (YY) and register number.

Note: The register numbering for the Y register is based on the octal numeral system
(base-8 number system).

Octa: 0 1 2 3 4 § 6 7 10 11 12 13 14 15 16 17 20 21

Decimal: 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17

In the following picture some DO channels have a comment to describe their task in the
control system.
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DO status: 3 | 2 Il The 1abel of each DO switch displays its associated
green - OFF f - register type: Y
red - register number

J._ J._

m@
Figure 15: Configuration interface of the i-8041 digital output module
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5.4.3 Digital IO configuration
This user interface is a combination of the digital in- and output configuration page. The
current status (ON/OFF), the assigned register type (X/Y) and register number of each
channel are displayed. Input channels are represented by an oval-shape icon and output
channels by a rectangular switch. The state of an output channel can be directly changed
by clicking the respective switch. A 30 character long comment can be edited to the text
box next to each channel to describe its role in the control system.

Channel status:
— green color represent OFF
— red color represent ON

Example:

Click on the image of the DIO module i-8042 in the third slot (see Figure 12). The i-8042
module has got 16 DI and 16 DO channels. The current state of each channel together
with the mapped register type (X or Y) and register number are displayed.

Note: The register numbering for the X and Y registers are based on the octal numeral
system (base-8 number system).

Octa: 0 1 2 3 4 § 6 7 10 11 12 13 14 15 16 17 20 21

Decimal: 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17
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- register type: X or Y and

green - OFF green - OFF - register number

red red -ON

El

& start NEEY . RPREh

Figure 16: Configuration interface of the i-8042 digital IO module
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544 FRnet configuration

The FRnet master module i-8172 has two ports (port 1 and port 2) and is preconfigured
by ICPDAS as follows:

The master can control via one port up to 128 digital output and 128 digital input
channels. For each master port the first 8 slave addresses (00 to 07) are reserved for
digital output modules and the remaining 8 addresses (08 to 15) are reserved for digital
input modules. ICPDAS provides two types of FRnet slaves: digital input devices with 16
channels and digital output devices with 16 channels. Therefore up to16 ICPDAS FRnet
modules can be connected to each master port: a maximum of 8 DI and 8 DO FRnet
slaves.

The user interface for the FRnet master module displays the FRnet slaves with their
FRnet addresses and their master port. For each FRnet slave a separate user interface can
be opened in which the current status (ON/OFF), the assigned register type (X/Y) and
register number of each channel are displayed. Input channels are represented by an oval-
shape icon and output channels by a rectangular switch. The state of an output channel
can be changed by clicking the respective switch. A 30 character long comment can be
edited to the text box next to each channel to describe its role in the control system.

Note: The register numbering for the X and Y registers are based on the octal numeral
system (base-8 number system). FRnet X and Y register numbers start from 1000 (octal
number).

Octal: 1000 1001 1002 1003 1004 1005 1006 1007 1010 1011 1012

Decimal: 512 513 514 515 516 517 518 519 520 521 522

Channel status:
— green color represent OFF
— red color represent ON

Example:

Click on the image of the FRnet module i-8172 in the fourth slot (see Figure 12). The
first eight rows represent the FRnet addresses (00 to 07) for the digital output slaves for
the FRnet master port 0 and 1. The remaining addresses (08 to 15) are reserved for digital
input FRnet modules.

In this example one digital output module (FR-2057T) with the address 00 and one digital
input module (FR-2053T) with the address 08 are connected to port 0 of the i-8172 FRnet
master module and one digital output module (FR-2057T) with the address 00 to port 1.

STEP 1: Enable the “Port 0: DO(00) Group” check box to integrate the digital
output module (FR-2057T) with the address 00 into the system.
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STEP 2: Enable the “Port 0: DI(08) Group” check box to integrate the digital
input module (FR-2053T) with the address 08 into the system.

STEP 3: Enable the “Port 1: DO(00) Group” check box to integrate the digital
output module (FR-2057T) with the address 00 into the system.

STEP 4: Click the “FRnet Config” button to add all three modules to the masters
polling list. The FRnet master will now access these modules.

1-5040 | 18041 | 18042 [ i-8172 }i-8017H]| i-8024 | Slot? ~ Efarplotl~

Step 3:
Add a digital output FRnet slave
with the address 00 to the master

Step 1: ort 1. -
Add a digital output FRnet slave m—
with the address 00 to the master 2k
ort 0. -
v/ 0 : DO(00) Group w| Port 1 DOCO0 Grop: FRnet )

Port 0 : DO01) Group Port 1 ; DO(01) Group Config Step 4:

Port 0 : DO(02) Groug Part 1 : DO(Dz) Graup Inform the FRnet master that

Port 0 ; DO(03) Group Port 1 ; DO(03) Group Exit

Port 0 DO(04) Group Port 1 DO(04) Growb xi three slaves have been added.

Port O @ DO(0S) Groun Port 1@ DO(OS) Group

Port 0 : DO(0A ) Groun Port 1 ; DO(0G) Group

Rt 0 DOW0TY Groes Part 1@ DO(07) Group

W Port O : DILDE) Grou Port 1 DIIOE ) Grou

Port 0 ; D09 Group ; DI(09) Grio)

Port 0 ¢ DIE10) Group Por Step 2-

Port 0 : DI{11) Group Port 1: DI{L .

Fort 0: DI{12) Group Pt oi oo M Add a digital input FRnet slave

Port 0 : DI(13) Group Port 1 : DI(13) Group with the address 08 to the master

Port 0 : DIil4) Group Port 1 : DIi14) Group

Port 0 DI(15) Grou Port 1 DI(15) Grou ort 0.

ﬂStart "ngCPDAS EzConfig Tools For... @*'ﬁ- 408 PM

Figure 17: Configuration interface of the i-8172 FRnet master module

STEP 5: To open the digital 10 user interface for a slave FRnet module click the
red button next to the slave.
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i-5040

To open the user
interface of an FRnet
slave click its red

button.
Port O D000 Groups v| Port 1 ; D000 Group
Portl . DO(01) Group Port 1 : DO(01) Group
Pl 0 : DO(02) Group Port 1 @ DO(02) Group
rt 0 DOI03) Group Port 1 ; DO(03) Group Exit

ort 0 ¢ D004 ) Group Port 1 : DO(04) Group
Port O @ DO(0S) Grous Port 1 @ DO(OS) Group
Port 0 : DO(0G ) Groups Port 1 ; DO(06) Group
Port 0 : D007 ) Group Port 1 : DO(07) Group

w| Port 0 ¢ DI(0S) Group Port 1 : DII0EY Grou
Port 0 ; DII09) Group Port 1 ; D097 Group
Port 0 ¢ DIE10) Group Port 1 ¢ D107 Group
Port 0 ; DIi11) Group Port 1 ; D111 Group
Port 0 ; DIE12) Group Port 1; DIE12) Group
Port 0 : DIE13) Group Port 1 : DIE13) Group
Port 0 : DIi14) Group Port 1 : D114} Group

Port 0 DIE1S) Grou) Port 1 DIE15) Grou

#7/start |[@l1cPDAS ExConfig Tooks For... | B )L 424 Pm @@

Figure 18: FRnet master configuration interface

STEP 6: Click the “0:00” button to open the user interface of the digital output
slave (address 00) of port 0. The state and the Y register number of each
channel are displayed.

Port 0 : DO(00) Groups v| Port 1 ; D000 Group

Port 0 : D01} Group Port 1 : DO(01) Group

Port O @ DO{02) Groups Port 1 @ DO(02) Group

Port 0 ; DO(03) Group Port 1 ; DO(03) Group

Port 0 ¢ D004 ) Group Port 1 : DO(04) Group

Port O @ DO(0S) Grous Port 1 @ DO(OS) Group

Port 0 : DO(0G ) Groups Port 1 ; DO(06) Group

Port 0 : D007 ) Group Port 1 : DO(07) Group

w| Port 0 ¢ DI(0S) Group Port 1 : DII0EY Grou

Port 0 ; DII09) Group Port 1 ; D097 Group L
Port 0 ¢ DIE10) Group Port 1 ¢ D107 Group —

Port 0 DI{11) Groupn Port 1 DI{11) Group 1005 | jL
Port 0 ; DIE12) Group Port 1; DIE12) Group

Port 0 : DIE13) Group Port 1 : DI(13) Group f d
Port 0 : DIi14) Group Port 1 : D114} Group

Port 0 DIE1S) Grou) Port 1 DIE15) Grou i 8

Figure 19: FRnet slave interface

Note:
The register number mapping may change if new FRnet slaves are added to the control
system.
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545 Analog input configuration

For each channel the analog input type (engineering unit and range), offset and gain can
be set. The configuration page displays the mapped register type (Al) and register
numbers. The polling of the input channels starts as soon as the scanning process has
been activated (“Input Scan”). A 30 character long comment can be edited to the text box
next to each channel to describe its purpose.

ach analog input channel'is automatically mapped to a register number of the
A 4 register type Al. The number can not be changed by the user.
5ain Mode

0:+/-10V H Select an engineering unit (ampere, voltage) and range for the input value.

Offeet

-0.5 Analog input offset.

Multiple

i

0.5
MOTE

Analog input gain.

i

test Annotation field
Input Walue

|—1.5|:||349 Actual input value = (measured value + Offset) x Multiple

Ii

5.4.5.1 Offset and Gain

Offset and gain commands are used for calibration. By setting offset and gain, you make
sure that values read from a field device are more accurate.

Offset
Offset is the difference between the minimum analog input value read and the actual
minimum analog value.

Actual Value = Reading + Offset

Example:

The module is set to measure a range 4-20 mA values. If the actual input signal is 4 mA and the module
reads a value of 4.006 mA then the offset is 0.006 mA. The offset represents the difference between the two
minimum values.

Gain

Gain is the ratio of the full-scale reading to the maximum input.
Actual Value = Measured Value * Gain

Offset must be calculated first; then gain is calculated.

10
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Example:

The module is set to measure a range 4-20 mA values.

If maximum input = 20.00 mA

and measured value = 20.40 mA

then gain = actual value/ measured value = 20/20.40 = 0.980392

The formula which takes the offset and gain into account:
Actual Value = ( Reading + Offset) * Gain

polled
input value
:: Gain error
20 mA e T % offset error
e
/J
//'
’/
'/
«/
,"/f
read value
l mmm actual value
’ Offset error
4 mA /
>
actual input value
4mA 20 mA

Example:

Click on the image of the analog input module i-8017 in the fifth slot (see Figure 12). The

i-8017 module has got eight analog input channels. The configuration page shows the

mapped register type and register numbers (Al 0 to Al 7).

STEP 1: Select the required gain mode (engineering unit and range) of the input

signal.

STEP 2: Calibrate all channels by entering the correct offset and gain (multiple)

values.

STEP 3: Save the calibration values by clicking the “Al Config” button.
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STEP 4: Click “Input Scan” to poll the channels.

.
| s

For each analog input channel
the mapped

- register type (Al) and

- register number
are displayed.

Geassssssssssss: I

ALO AlL A2 AL3 Al4 ALS Al G ALT
Gain Mode Gain Mode Gain Mode Gain Mode Gain Mode Gain Mode Gain Mode Gain Mode
[4ref-20ma[>] [4eef-2oma e [4ri2omale] |2er2sv [=] [2eesy (=] [2eesv [=] Joiov [w] Joeov [+
Offset Offsat Offsat Offsat Offsat Offset Offset Offset
jo.2 jo.a 0.7 o o o o o
Multiple Multiple Multiple Multiple Multiple Multiple Multiple Multiple
jLa jo7 jLoL J1 J1 J1 J1 J1
MNOTE MNOTE MNOTE MNOTE MNOTE MNOTE MNOTE MNOTE
|ﬂ0w rate |weight |temperature |temperature |: |: 5 5
Input Yalle Input Wallie Input Wallie Input Wallie Input Wallie Input Wallie Input Wallie Input Wallie
j0.322441 0.560214 j0.703609 jn.oozseres  joo091ss27  [D.OD1S2Ses [0.OD030S176  [-0.00488281

Al Config Iﬁ\_ Input Walue = (Real VT + Offset § x Multiple

Enter the channel Start polling the
configurations. input channels.

Figure 20: Configuration interface of the i-8017H analog input module

5.4.6 Analog output configuration

For each analog output channel the output type (physical unit and range), offset and gain
can be set. The register type (AO) and register numbers of each channel are displayed on
the configuration interface. Further more the user can directly output analog values by
using the configuration interface. A 30 character long description can be added to every
channel to specify its purpose in the control system.

1. Each analog output channel is automatically mapped to a register number of the
register type AO. The register number allocation is done by the EzConfig utility
and can not be changed by the user.
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&0 0 |Offset Multiple Okt
O+-10v | w|[0.5 2 15
|test

Select a physical unit (ampere, voltage) and range for the output value.

A0 Offset Multiple Ctput
O+-10v | wfj0.5 |2 |15
test

Offset value for analog output signal

A0 Offset Multiple Ctput
{0100 [=][p5 2 [1.5
ItESt

Gain value for analog output signal

A0 Offset Multiple Ctput
[orp-10v [=]fns E 1.5
ItESt

Default analog output value.

A0 Offset Multiple Ctput
[orp-10v [=]fns E I |
ItESt

Annotation field.

A0 Offset Multiple Ctput
o+-10v | »|[0.5 2 1.5
test |
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5.4.6.1 Offset and Gain for analog output

Offset and gain commands are used for calibration. By setting offset and gain, you make
sure that values sent to a field device are more accurate.

Offset
Offset is the difference between the minimum analog output value sent by the controlling
software and the actual analog value.

Actual Value = Sending + Offset

Example:

The module is set to a 0—-20 mA range. If the controlling program sends 0 mA and the channel actual output
value is 0.003 mA then the offset is 0.003 mA. The offset represents the difference between the two
minimum values.

Gain

Gain is the ratio of the actual output and the maximum value of the range sent.
Actual Value = Value Sent * Gain

Offset must be calculated first; then gain is calculated.

Example:

The module is set to a output range of 4-20 mA.
If maximum output sent = 20.00 mA

and actual value = 20.70 mA

then gain = actual value / value sent = 1.035

The formula which takes the offset and gain into account:
Actual Value = Value sent * Gain + Offset

actual output
-~ .
{ Gain error
2 _“_Offset error
p
20 mA gt
,//
)/
,/
//,f
~
///
e
{/
1//
,/
o~
z/,'
’/
J/
///
s actual output value
7
7 mmm  value send by master
1/,/
z/ ‘
, Offset error >
T output value send
by controlling program

20 mA

113



Example:

Click on the image of the analog output module i-8024 in the sixth slot (see Figure 12).
The i-8024 module has got four analog input channels. The configuration page shows the
mapped register type and register numbers (AO 0 to AO 3).

STEP 1: Select a suitable gain mode (engineering unit and range) for the analog
output channels.

STEP 2: Calibrate all channels by entering the correct offset and gain (multiple)
values.

STEP 3: Save the calibration values by clicking the “AO Config” button.
STEP 4: Test the configuration: Enter output values in the output filed and click

the “Output” button to directly send theses values to the corresponding
output channels of the i-8024 module.

1-8040 ] 1-8041 | 1-8042

T

For each analog output channel
the mapped

- register type (AO) and

- register number
are displayed.

& : &: Write
3

()
()
)
()
-
2
()
e
)
a
)
2
e
@
()

A0 0 Offsat Multiple Qutput Real WO = (Output x Multiple) + Offset

0 |=]f0.002 f1.004 fa.5

boiler ternperature — Enter the l_:hannel
EoT ] Offset Multiple Output configurations.

o |»]f-0.008 1.0007 jgo

outlet flow rate

Send the output

Eoz | Offset Multiple Output values directly to the
a [xljocoor  roo1 s - channels.
inlet fiow rate
EER | Offst Multipls Outpt
0 Ea|E f1 o

Figure 21: Configuration interface of the i-8024 analog input module
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5.5 Default startup settings

Non-10 related registers, such as the M, D, F, W, C, T, B, DW and MSG register, can be
set to a default value at program start. Furthermore a 30 character long comment can be
added to each register to clarify its purpose in the controlling program.

STEP 1: Click the “Edit” button to open the non-10 related register configuration
page.

ELERERLY

TPE | svmeoL | wal | noTE |
| ADD NEW SYMBOL |
8Start "@ICPDAS EzConfig Tools For... j@* [a3] L. 2:51 PM ulﬁ

Figure 22: Non-10 register settings

STEP 2: Select a register type which register numbers you would like to initialize
or comment.

In the following the procedure of assigning a default value is demonstrated by
using an M register type. The same procedure applies to the other register types.

STEP 3: Click the “M NOTE” button to open the M register list. The “M” symbol
at the bottom of the dialog window indicates that the list on the left hand
sight represents the M register list.

STEP 4: Enter a M register number which has to be initialized with a default

value at program startup. Enter a comment in the NOTE field (for
example: “My first annotation”).
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STEP 5: Add the register to the M list by clicking the “ADD NEW SYMBOL”
button.

M—— e aar———
18042 | 8172 |i-8017H| i-8024 | Slot7

TYPE | svmeGL | wal | noTE

1

MOTE
J1o [Py first annotation

3) Add the M register number to the list. g ADD NEW SYMBOL |

2) Enter a M register number.

Figure 23: Add a register to the register list

STEP 6: Double click the value field in the VAL column to set the initial value.

MNOTE|
o] o |
] &=

MNOTE
JL1 My first annatation

annotation

Double click the "NOTE"
field to change or add a
new comment.

Double click the "VAL" area
to enter a default value.

| ADD NEW SYMBOL |

Figure 24: Enter a default value and comment to a register

STEP 7: Add additional registers to the list by repeating STEP 4 to 6. To remove
a row from the list, click the “Delete” button.
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TPE | svmeoL | wal | noTE | M NOTE | - -

10 1 My first anniotation
‘ D NOTE | | T NOTE | -

11 u] Comment 2

12 1 Comment 3 - -

Cornment 30 W NOTE -
1

HOTE
fa1 |carment 20

| ADD NEW SYMBOL |

Figure 25: M register default value list

STEP 8: Close the register editor by clicking the “OK” button. Click “Save” to
save all settings.

5.6 Registry Key Editor

The registry key editor allows the creation, deletion and updating of device registry
settings. This tool is useful for protecting 3rd party applications running on the EzCore
engine.

To generate a registration key for the end user the program developer has to specify a
random 16 character product key. The encryption engine generates a registration key by
using the hardware serial number of the PAC and the product key. The product key is
only known to the system developer and should not be disclosed.

PAC hardware Product Key
serial number (only known to the system developer)

N\ 4

AES encryption
machine

'

Registration Code Key
(for the end customer)

117



The CHECK _KEY API requires the programmer to enter a product key and then it
generates from the registration code key entered by user and the hardware serial number a
product key and compares it to the real product key. The API returns a true when they
match.

STEP 1: Click the “Edit” button to open the non-10 related register configuration
page.

TPE | svmeoL | wal | noTE |
| ADD NEW SYMBOL |
8Start "*]ICPDAS EzConfig Tools For... j@* [a3] L. 2:51 PM ulﬁ

Figure 26: Non-10 related register configuration interface

STEP 2: Click the “Encrypt” button.

STEP 3: Enter your product key. This key must be 16 characters long. You can
choose any character sequence.

STEP 4: Click the “Get SN” button. The PAC hardware serial number will be
displayed in the “Serial Number” text box.

STEP 5: Generate the registration code key by clicking “OK”. This key will be
displayed in the “Registry-code Generator”.
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e
15042 | 18172 {i-8017H] |

2. Enter your product key.
This key must be 16 char long.
You can choose any character

sequence.

| svmeOL | waL

Serial Nurnber

4. Generate the registration S|
Registry-code Generator

code key |

— -W NOTE -De ete
C

etain register --> Clear all |
NOTE
Etain register —> FRAM_BACK.d{ B I

3. Get the hardware
serial number

|1AM_BACK.dat --» Retain registl{ |

ADD NEW S5YMBOL |

Figure 27: Encryption dialog

STEP 6: Exit the Encryption editor by clicking the “Exit” button. Click “Save” to
save all settings.
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6 EzGo

6.1 Introduction

The EzGo is a test utility program written for the Windows CE platform which allows the
user to test the basic operation of the motion control card and detect any malfunction in
the motion control system. EzGo assists the system developer in identifying any wiring
problem in the motion control system and helps the user to configure the system before
starting to write the actual control program. Parameter settings can be saved to a
configuration file.

At the present the EzGo utility supports the following motion control modules:

— 18092

— 18092F

— 18094

— 18094F
The i8094A and i8094AH modules can only be tested but the configuration can not be
saved to a file.

6.2 Using EzGo

The EzGo utility consists of four main windows:

1. Main page or selection page
The main page appears after launching EzGo. It allows the user either to open the
“Configuration”, “Basic_Operation” or “Advance_Features” window. At program
start the user is restricted to open only the “Configuration” window to first do the
necessary parameter settings.

2. Configuration page
This page enables the user to do the necessary hardware setting of the motion
control card in order for the card to be able to communicate with the servo motor.
The settings can be saved to a configuration file or previously saved configuration
can be loaded.

3. Basic operation page
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This page is for executing independent axis motion commands. A motor
representing an axis can be selected to execute a sequence of motion commands
regardless of other axes.

4. Advanced features page
This window assists you in testing different interpolation modes like 2/3 axes
linear interpolation and any 2 axes circular interpolation.

6.2.1 Selection window

@Cunﬁguratiun @Basic Operation Advanced Feature

Figure 28: Selection window

The selection window appears directly after program start. During program launch
all the slots of the PAC are scanned for any motion cards. In order for the scan
process to be successful make sure that no other program is running on the PAC
which accesses modules in the slots. The window provides the user with three
options:

— Configuration: hardware configuration of the motion control card

— Basic Operation: Single axis testing and point to point motion

— Advanced Features: Multi-axis interpolation testing, 2/3 axes linear

interpolation and any 2 axes circular interpolation.

From the selection page the user has to choose the required type of operation. Right
after program start only the configuration page can be selected. The motion control
card first needs to be initialized and configured before the other operation are
supported. Once the motion control card has been successfully initialized you can
advance to select the windows for single axis or multi axis motion.
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6.2.2

Initialization and configuration window

The configuration page is for setting the hardware signal configuration. It is mainly for

setting the
— Pulse output type
Pulse input type

Hardware limit signals

In-position input signal, alarm input signal
Logical level of the input signal

Configuration

----- Ais_x
----- Bz
----- Axis_Z
----- Ais_U

----- Axis_K
----- Ais_Y
----- Byis_Z
----- Axis_L

Output Pulse Mode
Encoder Mode :

Jow

-

|1/1 4B Phase -

Hardware Signal Settings

[ ] Enable Servo O

LIMIT+/- {Logic) Loy

HEAR HOME Ew

-

-

LIMITSTOP_MODE [5top

sudderily -

HOME (Logic) Low =

Z-Phase (Logic) [l ow =

Input Signal Settings
"] Enable TMP{RDY

["] Enable Serva Alarm

Type | Cornmand

Input Signal Delay Time:

Logic ILDW - LUQiCI Lo -
Input Signal Filter

["] EMG, LMT, ORG, SO [ ] INDEX []INP, &LM

[ ] EXP+j- [ M3

0.2 u (time unit

-

Other Settings

["] Enable WRING

[ ] Enable &WTRI

|1DDDD

| puse | seT |

"] Enable Mass

2000000 [lRue ST |

1]

ID

Switch To Test

Eﬂ Load Config

Figure 29: Configuration window

6.2.2.1

Parameter settings

The tree view lists every motion card detected in the slots with its respective name,
slot number and number of axis. The utility provides two methods to configure a

motion card:

Configuring all the axis of a motion module at once. In the tree view click the

name of the module. All the settings done will now apply to all axis of the

selected motion module.
Configuring each axis separately. To set the axis of a motion module card

individually just double click the name of the module to extend the tree view
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and select from the sub items an axis to open its configuration page. The
current configuration page always belongs to the axis which name is marked
by a blue background color in the tree view.

Therefore, if the module name is selected and highlighted by a blue
background color the setting done in the configuration page applies to all axis
of the module. If the name of an axis is highlighted the settings is only valid
for this axis.

..... M
----- Bz Y
----- Axis_Z
----- Aiz_L
----- Axis_K
----- Az
----- Bis_Z
----- Axis_L)

Figure 30: Detected motion cards

The setting of the parameters displayed in Figure 31 is essential.

Output Pulse Mode |CW -
Encoder Mode :
{1/1 a8 Phase -

Hardware Signal Settings
[ ] Enable Serva ON
LIMIT+/- (Logic) Lo = HOME {Logic ) Lo =
MEAR HOME Loy - Z-Phasze (Logic) [ ow -
LIMITSTOR_MODE Istop suddenly .

Figure 31: Required configuration

Select from the combo boxes the necessary options. The remaining settings of the
configuration page are optional.
You can also load a previous configuration from the configuration file.
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6.2.2.1.1 Pulse output / input type selection

Output Pulse Mode ;@

Encoder Mode :

Description

Pulse output mode setting:

PULSE (Faling Edge) f Dir -

W

oW

PULSE (Rising Edge) | Dir
PULSE {Faling Edge) J Dir

+
+

1f1 AR Phase

11 AR Phase
12 AB Phase
hase

This function sets the pulse output mode as either
CW/CCW or PULSE/DIR for the assigned axes and their
direction definition.

The related function is
SET_PULSE_MODE(BYTE cardNo, WORD axis, BYTE nMode);

Encoder related parameters

This function sets the encoder input related parameters.

A/B guadrature pulse input mode

When A/B quadrature is selected, the position counter will
count up if phase A leads Phase B; the position counter
will count down if phase B leads phase A:

1/1 AB phase:

Only the rising edge of A phase is counted.
— 1/2 AB phase:
The rising and falling edges of A phase are counted.

1/4 AB phase:

Both the rising and falling edges of A phase and B
phase

are counted.

Up/down pulse input mode

— Up/ down input

The counter counts at the rising edge of the positive pulse.
The A phase represents the count up input and B phase
the count down input.

The related function is

SET_ENCODER(BYTE cardNo, WORD axis, BYTE nMode, BYTE
nDivision, BYTE nZEdge);
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6.2.2.1.2 Hardware signal setting

Description

Setting the Servo Driver (ON/OFF)

[ Enable Servo ON This function outputs a DO signal (ENABLE) to enable the
motor driver.

Active level of the hardware limit switches

This function sets the active logic level of the inputs of the
hardware limit switches.

—  Low:
set the active level for the forward and reverse limit

switch to low.

LIMIT4/- (Logic)

— High:
set the trigger signal for the forward and reverse limit

switch to high level.

The related function is

SET_HLMT(BYTE cardNo, WORD axis, BYTE nFLEdge, BYTE
nRLEdge) ;

Trigger level of the NHOME sensor

This function sets the trigger level of the near home sensor
(NHOME).
Active level setting for the near home sensor:

HEAR HOME — Low =low active (0);

— High = high active (1);

The related function is
SET_NHOME(BYTE cardNo, WORD axis, BYTE nNHEdge);

Motion stop method

This function sets the motion stop mode of the axes when
LIMITSTOR_MODE |stop sudderly I~ the corresponding limit switches are detected.

—  Stop suddenly: Axis stops immediately when any limit
switch on the axis is triggered;

— Stop after deceleration: The axis decelerates to
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HOME (Logic)

Z-Phase {Logic)

standstill when any limit switch on the axis is
triggered.

The related function is
LIMITSTOP_MODE (BYTE cardNo, WORD axis, BYTE nMode);

Trigger level of the home sensor

This function sets the trigger level of the home sensor
(HOME).

Active level setting for the home sensor:
— Low =low active (0);

— High = high active (1);

Z phase trigger level

Sets the trigger level for the Z phase
— Low =low active (0);

— High = high active (1);

The related function is

SET_ENCODER(BYTE cardNo, WORD axis, BYTE nMode, BYTE
nDivision, BYTE nZEdge);
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6.2.2.1.3 Input signal settings

Input Signal Settings
["] Enable MP{RDY [7] Enable Serva Alarm

Logic ILDW v Logic I Lo -

Description

In-position signals

This function sets the active level of the in-position input
signals (INPOS input signal).

— Enable INPOS input signal
0 = disable INPOS input;
1 = enable INPOS input

Enable INF/ROY

—  Set the trigger level

Low = low active (0);

High = high active (1);

The related function is

SET_INPOS(BYTE cardNo, WORD axis, BYTE nMode, BYTE
nlEdge);

Servo alarm

This function sets the parameters of the ALARM input
signal.

— Enable INP/RDY
0 = disable ALARM function;
1 = enable ALARM function
Enahle Serva Alarm

Logic —  Sets the trigger level:

Low = low active (0);

High = high active (1);

The related function is

SET_ALARM(BYTE cardNo, WORD axis, BYTE nMode, BYTE
nAEdge) ;
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6.2.2.1.4 Input signal filter

Input Signal Filter

[ EMG, LMT, ORG, SD ] IMNDEX

[ ExP+j- [ Inz

[]INP, &LM

Input Signal Celay Time: |D.2 U (time urit)

.

These checkboxes enables you to select the input signals and set the delay time of the

filter.

Select input signal:

[ EMG, LMT, ORG, SD

[] INDEX

[P, ALM

[1ExP+/-

]z

FEn
Code

16

Input
signals

EMG

LMT

ORG

SD

INDEX

INP

ALM

EXP+/-

IN3

Description

Emergency

Hardware limit switch

—  positiv direction limit signal
(nLMTP)

— negative direction limit signal
(mLMTM)

Home signal (nIN1)

Slow Down signal
Near Home signal

(nINO)

index of Encoder input (Z phase)
(nIN2)

servo in-position input signal
(nINPOS)

Alarm input signal (nALARM)

External pulse (nEXPP, nEXPM,
EXPLSN)

nIN3

The sum of the FEn code humbers (0~31) are used to set the time constant for filtering

the input signals.

Example:
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Input Signal Filter

EMG, LMT, ORG, SD INDEX
[ ExP+j- []Inz
Input Signal Delay Tirme: |g.2 U (time unit) =

Selected options are:
Input signals FEn Code

EMG, LMT, ORG,SD 1

INDEX 2
INP, ALM 4
T FEn="7

SET_FILTER(BYTE cardNo, WORD axis, 7, WORD FLn)

Select delay time:

Input signal delay time

This function sets the time constant for digital filters of
the input signals:

Input signal delay time FLn code
2p SEC 0
256p SEC 1
512p SEC 2
1.024mSEC 3

Input Signal Celay Tme:  [0.2 0 (tme unit) = 2.048mSEC 4
4.096mSEC 5
8.192mSEC 6
16.384mSEC 7

The related function is

SET_FILTER(BYTE cardNo, WORD axis, WORD FEn, WORD
FLn)
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Other Settings

6.2.2.1.5 Other Settings

[ ] Enable WRMNG [ "] Enable AWTRI

| 10000

| Puke | sET |

"] Enable Maxi/

|2DDDDDD |F‘ulse | seT |

Enatle YRING

| 10000

| Puse | SET |

Description

Position Counter Variable Ring

This function sets the maximum number of pulses needed
in order to rotate one full cycle. This function is for
circular motion and not for linear motion and is useful for
managing the rotation position.

The related functions are
VRING_ENABLE(BYTE cardNo, WORD axis, DWORD nVRing)

VRING_DISABLE(BYTE cardNo, WORD axis)

Example:
The ring counter is set to 9999.

The encoder range will be from 0 to 9999. The counter will
reset to 0 when its current value is 9999 and it is
incremented by one pulse. A pulse count down by one will
result in a counter value of 9999 when the counter value is
currently 0.

angn 0 1
Sl as XN

/

The count operation will be as follows:

Increment in the + direction: ...
29998->9999>0>1->....

Increment in the - direction: ...
21-2>0-2>9999->9998->....

Triangle prevention of fixed pulse driving

This function prevents a triangle form in linear
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[ Enable &%TRI acceleration (T-curve) fixed pulse driving even if the
number of output pulses is low.

Acceleration
Drive Speed [ /
Acceleration(slope)
iti output pulse is too low, not
e 4~ suitable for the requirement
of drive speed

Time

The related functions are
AVTRI_ENABLE (BYTE cardNo, WORD axis);
AVTRI_DISABLE (BYTE cardNo, WORD axis);

Setting the Maximum Speed

This function sets the maximum rate for the output pulses
(speed). A larger value will cause a rougher resolution.

For example,

=  when the maximum speed is set to 8000 PPS, one
speed unit is equal to 1 PPS;

=  when the maximum speed is set to 16000 PPS, one
speed unit is equal to 2 PPS;

=  when the maximum speed is set to 80000 PPS, one
speed unit is equal to 10 PPS, etc.

The maximum value is 4,000,000 PPS, which means the
resolution of speed will be 500 PPS.

|2onc|000 |Pulse - seT |

This function changes the resolution of speed to reach the
desired maximum speed. Since the scale in hardware is
changed, other parameters will be influenced too, such as
the starting speed, the acceleration, and the jerk. It is
recommended to set the maximum speed value as an
integral multiplier of 8000.

The related function is
SET_MAX_V(BYTE cardNo, WORD axis, DWORD data);
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6.2.3

Basic Operation: Independent axis motion

Basic Operation

[~ 1-8094F in Siot:1
v

----- Ais X
----- Bois
----- Axis_Z
----- Az LI

Acc Mode
@ T-Curve
() S-Curve

Driving Mode ——
) Paint-to-Paint

() Canti. Output
() Manual Pulsar

Parameters

Start Welocity (Sy)  |20000 PRS

Drive Welocity (W)
Acceleration (&)

Deceleration (D)

Jerk (K}

20000 PRS on-fly change(v)
PPS/Sec on-fly change(A)

300 PPRS/Sec

500 PPS/Sec 2

Decelerating Rate (L) PPS/Sec~2

() HOME

K 222_}:’ AccjDec Sym Output Pulse 10000 on-fly change(P)
— Sy
..... Buis 7 @ sy Offset Pulse (40) IZI
..... Bis_LJ O RSy
Home Settings
NO | Cormand Mode |NearH0me,H0me,Lmt-JInde ~  Speed{HV) [soo0 PPS
Axis Status
Logic Position Encoder Position Error Current Speed
E | | | |Clear P/ERP| D | o |

Limit Switch and Homing Signals Servo Input Signals
LMT-  SLMT-  HOME NHOME SLMT+  LMT+ DR RO AL EMG

(9 Backward ° STOP Q’
Switch To Configuration @Ser\ru ON

Figure 32: Single axis testing window

Forward

@ Return

1] IC

Each axis of a motion card executes motion commands independent from the other axis
of the same module. Each axis move exactly as it has been programmed either from point
to point or in a continuous motion. Each axis will execute its motion commands
regardless of other axes.

|"_|"‘|_
Driver = P X

f |h|
Driver > 7 Y
Driver "—"* o Z

'
Driver = 7 U
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6.2.3.1

Configuration procedure

Step 1: First select an axis of a specific motion card. A selected axis is indicated
by a blue background.

----- 1-8094F in Slat:1

Step 2: Select the acceleration mode. T-curve and S-curve refers to the shape of
the velocity profile.

T-curve (Trapezoidal-curve)

In a T-curve profile the motor tries to go from 0 to the specified
acceleration instantaneously. When the motor is decelerating, it once
again goes from 0 acceleration to a negative acceleration as fast as it
can until it reaches 0 velocity and then abruptly stops. These abrupt
starts and stops reduce the life of mechanical components.

S-curve

The s-curve is used to slowly reach a certain acceleration or
deceleration value. Acceleration and deceleration changes occur
smoothly and thereby reduce the stress in the mechanical components.

MWax jerk at corners
of trapezoid

5

T- curve

Welocity

S-curve

Time

Step 3: Select the driving mode

Point to point motion

Continuous motion (Conti. Output)

Continuous pulse driving output:

The motion card will continuously output pulses at a specified speed
until is interrupted by a stop command or an external stop signal.
Manual pulsar

Output pulses are generated from a hand wheel.

Home
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If home has been selected enter the required home setting mode and
homing speed.

Home Settings

Mode MearHome,Horme, Lmt-, Inde [ SpeediHY) (500 PPS

MearHome, Home, Indesx, Lmt-
MearHore, Horme, Lmt- Indes, O

Step 4: Decide between a symmetrical and asymmetrical velocity profile.
= Symmetrical profile:

For the symmetrical profile the absolute acceleration and deceleration
values are equal.

Velocity
A

Drive Velocity (V)

Start Velocity (S8V) —/

T'@e

Acceleration/ Deceleration

‘ Acceleration Deceleration

Acceleration (A)

erk (K} Jerk (K Jerk (K

= Asymmetrical profile:

The asymmetrical velocity profile allows the individual setting of the
acceleration and deceleration values.
A

Drive Velocity (V)}-----—+---—

Start Velocity (V)

Time
Acceleration (A) Jerk (K) Deceleration
Increase Rate (L)
Deceleration (D) M p/
Acceleration Deceleration I
Time
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Step 5: Enter values for the motion parameters:

Parameters

Qutput Pulse
Offset Pulse (AO)

Start Velooity (S¥)  |20000 PRS

Drive Velodity (V) PPS
Acceleration (A) PPS{Sec
Deceleration (D) 500 FPS/Sec

Jerk (K} SO0 PRS/Sec 2

Decelerating Rate (L) PPS{Sec~2

on-fly change(P)

Step 6: Set the logic and encoder position to zero by clicking the “Clear LP/EP”

button.
Axis Status
Logic Position Encoder Position Error Current Speed
° | P

| [clear Lp/ER| [0 |

° |

Step 7: Enable the motor driver by clicking the “Servo ON” button.

Step 8: Now you can send the motion controller the motion command for the

selected operating mode.

The servo motor can either be moved in the

= Positive direction: click
= Negative direction: click‘ &

= To stop the servo motor click e—

positive or negative direction:

Forward

%

y Backward

STOP

motor to stop immediately.

. This button will cause the

If the driving mode is set to “Manual Pulsar” the motor follows the
outputting pulses of a manual pulse generator.

The command window on the bottom left list all the commands send to the control cards

with their specified parameter values.

| cornrnand |a

IB094MF_SET _W(1,2,20000)
IB094MF_SET_A0(1,2,9)
iB094MF_SET_54(1,2,20001)
IB094MF_NORMAL_SPEED(1,2,0)
iB094MF_SET_A{1,2,100000)
IB094MF_FIXED_MOWE(1,2,10000)

iB094MF_SET _W(1,2,20000)
IB094MF_SET_A0(1,2,9)
iB094MF_SET_5v(1,2,20000)
IB094MF_NORMAL_SPEED(1,2,0)
iB094MF_SET_A(1,2,100000)
IB094MF_FIXED_MOWE(1,2,10000)

4 ] [»]
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6.2.3.2

Status Indicators

The status indicators reflect the current state of the hardware limit, near home and home
switches. In addition the current state of the servo motor is displayed that means whether

it is in driving mode or has successfully completed the motion command. Alarm or

emergency stop events are also indicated.

Limit Switch and Homing Signals

LMT-  SLMT-

—— rServo Input Signals
HOME MHOME SLMT+  LMT+ DR RO

ALM

EMG

Input signals
LMT-
SLMT-
HOME
NHOME
SLMT+

LMT+

DRV
RDY
ALM

EMG

Description

Negativ hardware limit switch
Negative software limit

Home hardware signal

Near home signal

Positive software limit

Positive hardware limit switch

Servo motor is busy driving
Ready signal
Alarm input signal

Emergency
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6.2.4

Advance motion features: Multi-axis interpolation

Interpolation Modi Acc Mode -
) Linear 20 @ Const
() Linear 20 () T-Curve
() Circular () S-Curve

Axis Disposition
Bt [emds v
Soris2 [raais <+
£xis3 |Z_Axis—,

@ Sym
() Asym

Arc Mode AccfDec Sym —
@ o
O cow

Parameters

Start Welocity (WS ) 500 PPS

PPS/Sec

Deceleration (WD) 300

Drive Welocity (W)
Arceleration (Wa)

PPS/Sec

Jerk (WK 500 PPS/Sac™2

Decelerating Rate (L) |10000 PPS{Sec™2

Offset Pulse (wao)

MO

| Command

Finish Ponits § Center Pointers Settings

1]

IC

Output Pulse :  FP1 |1DDDD | FR2 |SDDD | FP3 |2DDD |
CenterPoirt: 1 [10000 | gz [0 |

Position Status
logicPosition:  LP1 (70511 | P2 [501S | P2 [o |
Encoder Posit, :  EPL [0 | 2 [0 | EF3 [ |

Clear LPfEP

‘ Backward

e Stop ‘-’Furward @Servu ON

@ Return

Figure 33: Multi-axis interpolation window

This window assists you in testing different interpolation modes. The 4-axis motion
control cards offered by ICPDAS perform any 2/3 axes linear interpolation and any 2
axes circular interpolation. Any 2 or 3 axes can be selected to perform linear interpolation.
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6.2.4.1 Configuration procedure

6.2.4.1.1 Linear interpolation

The following steps describe the procedure of executing a 2/3 axes linear interpolation:
Step 1: Select a motion module from the tree view on the left top screen by
clicking on one of the listed modules.

= 2509 Slot: 1
- § 1-3094F in Slot:2

Wi 18094 in Slot:3
W 1-8094F in Slat:4

Step 2:  Select the interpolation mode:
= Two axes linear interpolation
= Three axis linear interpolation

2-axis linear interpolation 3-axis linear interpolation

| Bat

Yy

Step 3:  Select an acceleration mode.
= Const — no acceleration
= T-curve
= S-curve

Step 4: Decide between a symmetrical and asymmetrical velocity profile.
= Symmetrical profile
= Asymmetrical profile

Step 5:  Select the interpolation axes. Any 2 or 3 axis of a motion module can be
selected to perform linear interpolation. The axis ports on the daughter
board are labeled as X-Axis, Y-Axis, Z-Axis and U-Axis. Axis Port: This
is the port number on the axis board which the motor is connected to.
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Step 6:

Step 7:

Step 8:

Step 9:

Step 10:

Axis Disposition —
mist [l v
Biis2 [r-mis v
Axis3 |2_Axis—v

Enter values for the motion parameters:

Parameters
Start Welocity (WS 500 RS

Drive Velocity (W) 2000 PPS
Acceleration (Wa) 1000 PPS/Sec

Deceleration (WD) 500 PPS{Sec

Jerk (VK] 500 PPS/Sec”2

Decelerating Rate (L) |10000 PPS/Sec2
Offset Pulse (WAO)

Enter for each axis the number of pulse to move from the current position.
Set the coordinates for the new position relative to the current position.

Output Pulse : Fri |1DDDD |FP2 |SDDD |FP3 |2DDD |

Set the logic and encoder position to zero by clicking the “Clear LP/EP”

button.

Position Status
Logic Position ©  LP1 |D | Lpz |D | LP3 |D |

Encoder Posit, :  EPL |7 | 2 o |EP3 E |

Enable the motor driver by clicking the “Servo ON” button.

Output the specified number of pulses to the servo motor. You can either
move in the positive or negative direction.

Forward

= Positive direction: click &

Backward

= Negative direction: click‘ &

STOP

= To stop the servo motor click e—
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6.2.4.1.2 Circular interpolation
The following steps describe the procedure of executing a circular interpolation:

Step 1:

Step 2:

Step 3:

Step 4:

Step 5:

Step 6:

Select a motion module from the tree view on the left top screen by
clicking on one of the listed modules.

1-9094F 2
Wi 18094 in Slot:3
Wl 1-8094F in Slat:4

Select the interpolation mode:
= Circular interpolation

Select the direction of the circular interpolation.
= Clockwise (CW)
= Counterclockwise (CCW)

Decide between a symmetrical and asymmetrical velocity profile.
= Symmetrical profile
= Asymmetrical profile
Circular interpolation only supports the T-curve acceleration mode.

Select the axis for the interpolation. Any 2 of the 4 axis can be selected for
circular interpolation. The axis ports on the daughter board are labeled as
X-AXis, Y-Axis, Z-Axis and U-AXis.

Axis Disposition —
I}(-Axis -
IY—A}{is -
IZ-Axis -

Axisl
Axis2

Axis3

Enter values for the motion parameters:
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Parameters
Start Welocity (WSW) 500 falul

Drive Welocity (W) 2000 PPS
Acceleration (Wa) 1000 PPS/Sec

Deceleration (WD) 500 PPS{Sec

Jerk (WK S00 PPS/Sec "2

Decelerating Rate (L) |10000 PRS/Sec 2
Offset PLise (VAD)

Step 7: Enter the center point and for each axis the number of pulse to move from
the current position.
The circular interpolation starts from the current position. Therefore it is
assumed that the current position (start point) is (0,0). After setting the
center point, finish point and the direction (CW or CCW), the user can
start the circular interpolation.
Note: The coordinates are relative to the start point.

Finish Ponits / Center Pointers Settings

Output Pulse : FP1 D Fr2 |-2UDD |FP3 |2000 |
Center Point P1 P2

Axis2

CCW circular interpolation Start Point (0. 0)

Center Point
1000, - 1000)

>
Axis1

CW circular interpolation

Finish Point (0, -2000)

Step 8: Set the logic and encoder position to zero by clicking the “Clear LP/EP”

button.

Position Status
Logic Position : ~ LP1 [0 | P2 o |2 o |
Ercoder Posit. ©:  EP1 |D | EFz |D |EP3 |D |

Step 9: Enable the motor driver by clicking the “Servo ON” button.
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Step 10: Output the specified number of pulses to the servo motor. You can either
move in the positive or negative direction.

ow

= Clockwise direction: click

= Counterclockwise direction: click

accw

Stop
= To stop the servo motor click °
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/ EzMake

7.1 Introduction

EzMake is a utility which assist the user in programming, debugging and testing simple
motion control macros. It can only be used together with the i-8094H motion control
module. The macros have to be called by the motion control program written by the user
in C. The advantage macros is that for minor changes instead of modifying and
recompiling the main program only the macros have to be changed and downloaded to
the motion module. The controller can therefore be adapted very quickly to the new
requirements.

The EzMake utility provides the operator with a list of valid commands and prevents the

input of invalid commands or parameters. With EzMake you can create three different

types of macros:

— Initialization macro: Responsible for the basic configuration of the motion card.

— Motion control macro: This macro contains the actual motion control command
sequence.

— Interrupt service routine macros: Is being called when an interrupt of the motion card
occurs.

These macro files have to be downloaded to the i-8094H module. Macros are stored in a

nonvolatile memory.

7.1.1 Main user interface

The tree view on the left lists the project files and the three macro file types created by
the user: Initial table, Macro program and Interrupt Service Routine. The middle section
of the main window forms part of the macro editing interface. Here the user has to edit or
modify motion commands and their parameter for the different macro programs. The
section on the right lists all the motion and macro commands supported by the i-8094H
module. The commands can be selected from the command list by a double click. For
some files types certain commands can not be used and are therefore disabled. Disabled
commands show their icons in gray color tone. The window at the bottom informs the
user about programming restrictions and different axis and motion statuses for online
debugging.
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EzMake - 17PDAS - Project

T ] 18094H Resource
= E Froject
=) 10241400.prj
=] Initial Table
B 1400t
= |l Macro Prograr
= [E] 1400.mp
&H mp1
& vpa
& mps
& me7
F ]
[= b Interrupt Ser
= [£] 1400.isr
A& 15R2
L [SR4
A ISRE
= ﬂ Machine Data
=[] 1400.md
i MO0
e MD2(
il MD2(
g MD20
sl MD2(
iala MD2CY

2] Initial Table
I Macro Program

Control push buttons

Macro command category

Save Remove [

oi L)
e
g

e No Supported Furlctions

Project S
Initial Table - 1400.it

Macro Program - 14
Interrupt Service Rd
Machine Data - 1401

Macro function and paramter input

area

tree view

'Program and
iproject files

)’

Macro command list

# SET_PULSE_MODE

z # SET_MAX_V

# SET_HLMT

K] LIMITSTOP_MODE

g SET_NHOME
ﬂ SET_HOME_EDGE

‘Message | axis Status | Hardware Signals | Debug |

@ SET_SLMT
@ CLEAR_SLMT

@
L SET_ENCODER

g SERVO_ON
=11

_E SERVO_OFF
I I

Initial Table:

table.

mE i Wl

d

There is one Function table in each *.it File, you can re-modify the initial parameters in the current initial Function

status window

_‘-ﬂlnﬁ‘omation and

Figure 34: EzMake user interface

7.2

EzMake - ICPDAS - Initial Table

Fle  Wiew Buld Help

=77 8094H Resouzce

Initial Table

@ ey BH

Save Remove Download R

Ereate WEER

Q No Supported Functions -

okf x|

i AT
LA

i m Project

1 | Initial Table
MyInitialTable it
| Macra Program

i o Intermpt Service Koutine
e ﬁ Machine Data

Figure 35: Initialization

MlyInitialTable it

SET_PULSE_MODE
SET_MAX_V
SET_HLMT
SET_LIMITSTOP_MODE

SET_FILTEE
VRING_ENAELE_DISAELE

AWTEI ENAELE DISAELE

commands

Initialization commands

The initial table lists all the commands necessary to initialize the i-8094H module. The
sequence of the commands is fixed and commands can not be removed from the list. In a
newly created initial table all commands have default parameter values. Double click a
command to change its default value(s).
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7.2.1
Step 1:

Step 2:

Step 3:

Step 4:

Step 5:

Step 6:

Create a new initialization table

Open the “i8094H Resource” tree in the tree view on the left hand sight to
display the following five folders:

-] Initial Table
----- | Macro Program

Click on the “Initial Table” folder.
[=)- 7] i8094H Rescurce

----- m Project

| Macro Program

G Intermupt Service Foutine

Click File >Create to create a new initial table. You can also directly click
the “Create” button in the toolbar.

In the dialog box enter a name for the initial table and click “OK”.

IT Resource Configuration

Fil= |MyIr|iti.a1Tab1e || oK I

Drescriptior Canrel

The new table will be added to the “Initial Table” folder.
Note:

i. The new table is visible in the “Initial Table” folder but the file in
fact has not been created yet. It will only be created once you save
the table.

ii. You can add at most 5 tables to the Initial Table folder.

-7 i8054H Resource

SRISA}11:iti= Table

] Htran

Click on the newly created table. The command sequence for initializing
the motion control module appears in the middle section of the main
window. The commands and command sequence can not be change but
the parameters of the commands have to be modified to meet your motion
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control requirements.

MyInitialTahle it

SET_PULSE_MODE
SET_MAY_¥

SET_HLMT
SET_LIMITSTOP_MODE
SET_NHOME
SET_HOME_EDGE
SET_SLMT
SET_ENCODEE
SERVO_ON_OFF
SET_ALARM

SET_INPOS

SET_FILTER
VEING_ENABLE_DISAELE
AVTRI_ENAELE_DISAELE

Step 7: Save the initialization table: Click on the table folder and then the “Save”

1.2.2

Step 1:

Step 2:

button of the toolbar. The table filename extension is . it.
The file is saved to the following directory:
“\System_Disk\EzProg-I\EzMake”

Modifying a initialization table

Click on one of the initialization table in the “Initial Table” folder to

display its initialization commands. Initialization tables in the tree view

are identified by names ending with . it . Remember that it is neither

possible to remove a command nor change the command sequence in the

table.

Double click a command to open the window for editing the function

-7 i8094H Resource

] Initial Table

1=
|E] nitTable_2.it
|5 InitTable 3t

|| Macro Program

parameter.
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0@
1d O &

@ vy BHA

Create. Cper Save Remove Jownload R

Fle  Wiew Build Help
=7 8094H Resoures
Project
1] Tnitial Tahle
MyInitialTable it

- |Z] InitTable_2it
...... =] InitTahle 3t
| Marro Program
fe| Interrupt Service Routine

IT Function Editor

MyInitialTable it
SET_PULZE_MODE

Double click a command I‘

Function Name [SET_PULSE_MODE

Paramsterdxis | X-huis | Y-hxis | C-dxis | U-duis |

nhiode o o o o

Step 3: Click on one of the parameter to enter or select the parameter value(s)
according your system requirement. Confirm the new setting by clicking

L‘OK”.

IT Function Editor

Function Hame ISET_PULSE_MODE

v| OKl

Parameter\ dxis | Hodixis | Voools | Zocis | Uolicis |
nMode 0 1 v 0 i]

0

Th & W b3

Step 4: After all the parameters of the initializing commands have been set save
the file (toolbar: “Save”).
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7.2.3

Open an initialization table file

Step 1: Open the “i8094H Resource” tree in the tree view on the left hand sight.

m Praoject

1] Tritis] Table

| Macro Program

el Intermpt Service Foutine
ﬁ] Machine Data

Step 2: Click on the “Initial Table” folder.

-7 i8094H Resoures

WBlFritic] T
----- || Macro Program

------ | Intermupt Service Routine

------ z] Machine Data

Step 3: Click File 2Open to select an existing file with the extension _it. You

can also directly click the “Open” button in the toolbar. Make sure that the
file you select is in the following directory:
“\System_Disk\EzProg-I\EzMake”

0pen|||‘i‘i‘”?§_ |°K|><

[3) \CompactFlash\EzProg-TI\EzMake

[i8094H_API_en.files

InitTable_z

InitTable_3
Tnitial Table

star

Name: [MylnitialTable Type: [IT Fies(*.IT} =

The table will be added to the “Initial Table” folder:

=177 i8094H Resouzce

. (R Initial Table

(B s ]

----- | Macro Program
----- fl Interrupt Service Routine

------ ﬂ Machine Data
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7.2.4 Remove an initialization table from the tree view

Initialization tables can be removed from the tree view without actually deleting the file.
You can always add the file again to the “Initial Table” folder.

Step 1: Select the initialization table you like to remove from the “Initial Table”
folder.

-7 i8094H Resouree

SRy Initial T able it
=] InitTable 2t
=] InitTahle 3t

| Macro Program

i jue| Interrupt Service Routine

------ ﬁ] Machine Data

Step 2: Click the “Remove” button in the tool bar.

7.2.5 Downloading of an initialization file

After the initialization table has been set it can be directly downloaded to the i-8094H
motion module.

Step 1: Select the initialization table you like to download to the i-8094H module.

-7 i8094H Resoure

S My Tnitial T ble it
=] InitTable 2.t
=] InitTable 3t

| Macro Program

frl Jl Interrupt Service Routine

------ z,] Marhine Data

Step 2: Click the “Download” button in the tool bar. The file will be downloaded

to a non volatile memory of the i-8094H module and will immediately
initialize the module to the new setting.
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7.3 Macro Program Files (MP Files)

The main task of the EzMake utility is to assist the user to write motion control macros
for the i-8094H module. The utility always provides the user with a list of available
motion commands for the respective macro and thereby ensures that not an incorrect
command is being used. In addition the utility supports debugging your macro.

A macro file contains one or more macro forms called MP. The i-8094H supports up to
157 macro forms (MP1~MP157) with different sizes (stacks). The size indicates how
many command lines a macro form supports. Therefore a macro form has to be selected
according to the number of motion commands to be used in a macro. The macro forms
are divided according to their sizes into five categories (8/16/32/64/128/512 stacks). A
macro form with a stack size of 32 has space for 32 instructions. The user can add up to
157 macro forms to one macro file.

7.3.1 Create a new macro file

Follow the steps to create a new macro file:

Step 1: Click on the “Macro Program” folder.

Step 2:  Click File >Create to create a new macro file. You can also directly click
the “Create” button in the toolbar.

Step 3: In the dialog box enter a name for the macro file and click “OK”

MP Resource Configuration

File Harme | |MyMacro | ||8 Stacks - o

MFHo | Description MP Ho - —
MF1
MP2
MP3 Add MP
MP4
MF3
i Del MP
MP7

MPE

MFP7

MP10
MP11
MP12

Eja.

MF13
MFP14
MFP15
MFPl& -
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Step 4:  The name of the new macro file will be added to the “Macro Program”
folder.
Note:
i. The actual macro file has not been created yet. It will only be
created once you save the macro file (see next step).
ii. You can add at most 5 macro files to the “Macro Program” folder.

E| | Macro Program

] | Intermupt Service Routine

Step 5:  Save the macro file: Click on the name of the macro file in the tree view
and then the “Save” button of the toolbar. The macro filename extension
is .mp.

The file is saved to the following directory:
“\System_Disk\EzProg-1\EzMake”

7.3.2 Adding a macro form to a macro file

Each macro file can save up to 157 macro forms. The macro forms are numbered from
MP1 to MP157. It is only possible to add one macro form of the same number to the
macro file.

The next steps describe the procedure to add a macro form to a macro file:

Step 1:  Click on the macro file folder you want to add a macro form. In the
following picture the macro file is MyMacro.mp.

[ [3] Imitial Table
E| | Macro Program

b a MyMacro.mp

i | Interrupt Service Routine

------ ﬁ] Machine Data

Step 2: Click the “Create” button in the toolbar.

Step 3: Determine the number of command lines the macro form has to support.
Six different form sizes are available. Always make sure that a form is
selected which provides more command lines and not less than is actually
needed for the macro. For example if the macro has to hold 20 commands
then a macro form with 32 stacks has to be selected.
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MP Resource Configuration

Fils Harme |MyMam-mp

MF Nao | Diescription

Step 4: Double click a macro name to add it to the macro file list. More than one
macro form can be selected.

MP Resource Configuration

File Hame |MyMscro mp REESE - i
MPF Hao | Diescription MP Ha - Caneel
MP3R5 MP21

uiag.

MP3s MPa2
MEP7 \ MP23 Add MP
Diel MP

Double click a suitable
macro form to add it to the
list.

Step 5: Click “OK”. The name of the new macro forms are shown in the macro

file folder.
Note: The macro forms have not been saved yet.

[=)- 77 i8094H Resource

=] Macro Program

= o]

----- | Intermupt Service Routine
----- ﬁ] Machine Data

Step 6: Save the macro file: Click on the name of the macro file in the tree view
and then the “Save” button of the toolbar.

Step 7:  Now start adding motion control commands to the macro forms.
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7.3.3 Open a macro file

A macro file is a file which contains one or more macro programs. When a macro file is
opened all the macro forms in the file will be loaded to the utility.
The following steps describe the loading procedure:

Step 1: Open the “i8094H Resource” tree in the tree view on the left hand sight.

1] Tnitial Table
-l Macro Program

Step 3: Click the “Open” button in the toolbar. Make sure that the file you select
is in the following directory:
“\System_Disk\EzProg-I\EzMake”

open| 1 | o i & oK | x
[3) \CompactFlash\EzProg-I\EzMake

i8094H_API_en.files
Mame: [MyMacro Type: |MP Fies (*.1P) -

The table will be added to the “Macro Program” folder:

=77 i8094H Resoures
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7.3.4 Writing macros (motion commands)

The motion commands can not be edited via keyboard to the macro form but has to be
selected from the command list. Consult the i-8094H user manual for a detailed
description of the individual commands. This section describes how to use the EzMake
utility to write macro programs but does not give any assistance in writing an actual
motion control macro program.

7.3.4.1 Adding motion commands to a macro form

Step 1: Click on a macro form of a macro file. For example “MP95” in the
following figure:

-7 B094H Resource

..... E Project

..... ] Iritial Table

=] Macro Program

E| MyMacro.mp
w

----- | Interrupt Service Routine
..... ﬁ] Machine Data

Step 2: The motion commands are arranged into 11 categories to facilitate the
selection. Select a command category.

ting Fanctions|

ing Funetions
Status Functions
FFnet DIO Fanctions
Auto Home Functions
& xcis hlove Functions
Interpolation Fanctions
Synchronous detion Functions
(Contirmconus Interpolation Funetions
Interrapt Control Funetions
(Other Functions
Macra Program Funetions
Full Fanctions

After selecting a category a list of motion commands appears on the right
side of the utility window.

Step 3: Double click a command to add it to the macro form.
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Fle  Wiew Buld Help

=) 7T7) i8094H Resoures Create. Oper

® ¢

Saye Rernowe Do

Myblacrs mp L MP25

=l Macro Program
E| . Myblacro . mp

MP Function Editor

Double click the
required command.

Function Name |i8094H_SET_PULSE_MODE

Paramster | Vlane | Chaick Salact
..... zj Marhine Data cardllc 1 =

axis AXIS X¥EZT  Click

nhlode 1] Click

Seriteh

I g E
_ x|

T_PULIE_MODE

@ SET_MAX_¥
# SET_HLMT

B3| LirTsToR_MoDE

EJ SET_WHOME
EJ SET_HOME_EDGE

% SET_SLMT
# CLEAR_SLMT

@ann
EEIn.rL SET_EHCODER

é SERVO_ON
% SER¥O_OFF

OFF

L SET_ALARM
< | T»

Step 4: Set all parameters for the command. Click with the mouse on the row of a

parameter in the “Quick Select” column to open a combo box with all

possible parameters values.

MP Function Editor

Function Hame |i8094H_SET_PULSE_MODE

Paramster | Vlae | Chaick Select
cardHa 1 -
anis AXIS X Clicl
nblods 0 )

1

2

K

4

5

Swritch

<
I g E
_ |

Step 5: After all the parameters have been set close the dialog window by clicking

“OK”. The new command will be added one line below the last macro

command in the macro form.

== . - - e e | ~
@ 45y BHE 1559
Createl OEer Saye Remove Dovileac R .j ‘.—' ‘_
MybMacro mp | MP35 | index

1

[] i8094H_SET_PULSE_MODE

Step 6: Save the macro file after you have finished editing commands to the

macro from: Click on the name of the macro file in the tree view and then

the “Save” button of the toolbar.
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7.3.4.2 Modifying a macro program
A command in the macro form can be manipulated in the following way:

Icon Description

Move command up one line

<)

() Move command down one line

> Move command to the first line

(] Move command to the bottom line
@ Delete command

Parameter values are change by double clicking the command in the macro form. The
parameter window popping up allows you to modify the existing values of the selected
command.

Myhlacys mp \ MPI5S Double Click | indeze
[] i5094H_SET_PULSE_MODE

[] i8094H_SET_MAX_¥
[] i2094H_LIMITSTOP_MODE
[] is0%4H_SET_WHOME

MP Function Editor

Function Hame [i3094H_SET_HLMT -

Parameter | Vlaue | Chuick Selact
cardHa 1 -

axis AXIS XYZU  Click
nFLEdze 0 Click
nFLEdze 0 Click

(9]
o [EI [
Ié i
[ x|

Swritch
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7.3.5 Downloading and executing a macro file

After the macro programming has been completed the macro files has to be downloaded
to the i-8094H motion module.

Step 1: Select the macro file in the “Macro Program” folder you like to download
to the i-8094H module.

=)- L7 i8094H Resouree

Step 2: Click the “Download” button in the tool bar. The file will be downloaded
to a non volatile memory of the i-8094H module.

Step 3: Now you can directly call and execute the macro on the i-8094H module
and monitor the command executions. Select a macro from the macro file
and click the “Run” button on the toolbar.

; . ; [ - =
Fil:  Wiew  Euild  Help @ @ g’ 13’ g .j'-j"-j@l
= __:| i20%4H Resource Create.  Dpen Gave  Remove Dowmload L a {Io 2
'''' & Project MyMacro.mp \ MF25 LN || index
..... 1] Initial Table i8094H_FIZED_MOVE \ 1
B i8094H_FIZED_MOVE 2
i8094H_FIXED_MOVE 3
i8094H_FIXED_MOVE 4

[

----- f| Interrupt Service Routine
..... ﬁ] Machine Data

The utility highlights the command currently being executed by the
motion module. Axis statuses such as the logic position, encoder position,
velocity and acceleration are displayed in the “Axis Status” tab window at
the bottom of the utility. The debug tab window shows which commands
have been successfully carried out. The execution of the macro commands
can be stopped or aborted at any time.

Icon Description

[ Halt macro execution

@ Continue macro execution
al Cancel macro execution
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Step 4: After the last command has been executed click the [€l button in the
toolbar to end the macro execution mode.
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7.4 Interrupt Service Routine (ISR) macro

A macro called by the interrupt service routine is created in the same way as a normal
motion control macro described in the previous chapter. The 8094H manual (chapter 6.3)
describes in detail the procedure to enable the ISR and link the ISR to a macro. The
8094H module is designed to store up to 20 macros (ISR1 ~ ISR20). The macros are
categorized according to the number of commands they can hold (8/16/32/64 commands).

The procedure for adding, deleting, saving and loading of macro forms is very similar to
the procedure of a normal motion control macro. The only difference is that the interrupt
macro forms are created in the “Interrupt Service Routine” folder and that they are called
(ISR1, ISR2, ISR3...). The editing, downloading and testing of an ISR macro is identical
to the motion control macro described in the previous chapter. Therefore consult the
chapter 7.3 for implementing an ISR macro.

EzMake - ICPDAS - Interrupt Service Routine m
Fil:  Wiew Buld Heb 1‘@ S o ?\3’ g (T & & glgxf Morve Fanctions :|
= _J 18094H Fesource Create  Qpemn Save  Remove Download L .Cj ‘-—" ‘-_'-\ MORMAL SPEED ;
""" & Project | #yIntermpt isrt I5RID | index
----- 3] Initisl Table [ ] i8094H_FIXED_MOVE 1 SET_SV
-l Macro Program [ ] i2094H_FIXED_MOVE 2
[l--humd Irtterrapt Service Romtine  ||[] i8094H_FIXED_MOVE 3 SET_W

E| MyIntermpt isy
- gy TSRIO
----- ka IRI1Z
. ot
----- ﬁ] Machine Data

SET_&

SET_D

SET_K

SET_L

SET_A0

SV PPV PP D H

SET_FPULIE I

? FIXED_MOVE DE

| Message | Axis Status | Havdware Signals | Debug |

Logic Encaoder Tracking Exrar Current Speed Current & cceleratoin
- o o 0 Pps [0 PPiiSec
V- o o o Pps [0 PPSfSec
E-duxis [0 o o PP [0 PPifSec
U-dxis |0 0 u PR |0 FFSifec

Note:
In an ISR macro no “for” loop is allowed and it is not possible to call inside an ISR
macro a MP macro.
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7.5 Project Files

So far files for the three different macro types had to be created and saved individually.
By creating a project file all these macro files can be saved, opened and downloaded at

once.

7.5.1

Step 1:

Step 2:

Step 3:

Step 4:

Create a new project file

Click on the “Project” folder.

Fil:  Wiew Buld  Help

=M _1 18094H Rescurce
b m Project
3] Tmitial Table

L Macro Program

Click the “Create” button in the toolbar.

In the dialog box enter a name for the project file.

EzMake - Project - Create
Project - Creat { Open

Project Mame: IMvFirstPrDject PRI

Initial Table

Macro Program

Interrupt Service Routine

Machine Data

1| I IT (Oicreate () Open
1 |vP I MP (O create (O Open
[] |IsR: I sk (O create (O Open
1 | mo: I Mo O create () Open Cancel |

Determine which macro types the project file should include. In the
following the “Initial Table”, “Macro Program” and “Interrupt Service
Routine” are selected. Furthermore the “Create” options have to be
selected to indicate that these macros types are newly created. All the
newly created macro types automatically adopt the name of the project file.

The names can be changed.
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EzMake - Project - Create
Project - Creat { Open

Project Mame: IMyFirstProject BRI

Initial Table

v |IT: |MvFirstPruject IT @ create () Cpen

Macro Program

| = IMyFirstProject MP @ cCreate () Cpen

Interrupt Service Routine
I |1k IMyFirstPrUject I5R @O () Open

Machine Data
] MD:I Mp O create (O Open Cancel |

Step 5: Confirm the selection by clicking “OK”.

Step 6: Confirm or change the name of the initial table. In addition you can add a
comment to the file to describe its purpose. Click “OK”.

IT Resource Configuration

Fil= IMyFixsthject

Descriptior

Step 7:  Confirm or change the name of the macro program file. Add one or more
macro forms to the macro program file by double clicking a macro form
name. Click “OK”.

=

MP Resource Configuration

File Hame [MyFisstProject |64Stacks E|| 0K I
FY

MPHo | Description ME Ha
MP133 MP131
MP136 MP132
MP140 MP133 Add MP
MP134
MP135
MFP136
MFP137
MP138
MEP133

ancel

il

Del MP

MP141
MP142
MP143
MFP144

MFP145
MFP1l4s E

Step 8: Confirm or change the name of the interrupt service routine file. Select
one or more macro forms to the ISR file. Click “OK”.
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ISR Resource Configuration

E

File Name IMyFi.rstProject

IS Stacks E| | I

ISEHo | Description ISR Ho Cangel
ISR3 ISR1
ISE2
ik Add SR
T5R4
ISES
i Del ISR

Step 9:  The newly created project is now added to the “Project” folder.

) i2094H Fesoures

Note:
The new project file is visible in the “Project” folder but the file in
fact has not been created yet. It will only be created once you save
the project.

MyFirstProject it
]| Macra Program
E . MyFirstProject.mp

E| —| Intenupt Service Routin
E| . MyFirstProject isy
| i TSRS

------ ﬁ] Machine Data

Step 10: Save the project file: Click on the newly created project name in the tree
view and then the “Save” button in the toolbar.

EzMake - ICPDAS - Project

Fil:  Wiew Euild Help

= _'| 13094H Resource

MyFirstProjec
== | Macro Program
E| . MyF].rstPrDJec

] Intenupt Service B
2] MyFirstProjec
H b &a I5E3

...... ﬁ] Machine Data
..... L] Initial Table
..... || Macro Program
----- fe Interrupt Service Rontine
..... %) Mackine Data

=] P = R
oo aﬁ‘;g?niigenadg el

Project

Initial Table - MyFirstProject it

Macrs Progeam - MyFirstProject mp
Interrapt Service Routine - MyFistProject 15y
Machine Data -

| 2. Click "Save"

1. Click the project name in the tree view
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The project filename extension is .prj. The file is saved to the
following directory:
“\System_Disk\EzProg-I\EzMake”’

Step 11: Now you can start editing the macros.

7.5.2 Downloading a project file

After finishing the macro programming the complete project files can be downloaded to
the i-8094H motion module at once or the different macro file types can be downloaded
separately.

Step 1: Select the project file in the “Project” folder you like to download to the i-
8094H module.

EzMake - ICPDAS - Project

;\,'i @ 5 ?“’ allZ] T
S I Y 3@ C
Create  Dpen Sawve FRemove [Dowmload | Q) & S

Project
Initial Table - MyFirstProject. it
Marro Program - MyFirstProject mp

| B P Interrapt Service Foutine - MyFirstProject isr
s acro Program Machine Data - e e . .
ol termpt Serviee Roatime || 1. Click the project name in the tree view

/) Machine Data 2. Click "Download"

If you want to download the different macro types separately, just click on
the macro file type ( in this example: MyFirstProject.it,
MyFirstProject.mp or MyFirstProject.isr) and then the “Download”
button on the toolbar.

Step 2: Click the “Download” button in the tool bar. The complete file with all the
macros will be downloaded to the non volatile memory of the i-8094H
module.

Step 3:  Now you can directly call and execute the macro on the i-8094H module

and monitor the command executions. Select a macro from the macro file
and click the “Run” button on the toolbar.
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EzMake - ICPDAS - Macro Program

Ele ¥iw Buld  Help @ : p.’ ! g D0 D
= _'| 18094H Resouree Croate Open Gave ERemowe D .5 {." N
=R E Project MyFirstProject mp 4 MP133 | index
B . MyFirstProject prj iE094H_FIZED_MOVE 1
=X _| e —— iB094H_FIZED_MOVE 2
: iB094H_FIZED_MOVE 3
""" B #yFustProgec|| 5004n FrED_MOVE 4

E| J acro Program

. MyFirstProjec
E| _I Interrupt Zervice F||

E| . MyFirstPrajec
o g ISE3

------ ﬁ Ilachine Drata

..... (1] Tnitial Tahle

----- | Macro Program

----- | Intterrupt Service Routine
----- ﬂ Machine Data

7.6 Macro motion commands

The following table introduces the macros supported by the EzMake utility. The 8094H
manual describes these commands and their parameter setting in more detail. The
EzMake support three macro types:

— Macros for module initialization (IT)
— Macros for motion control (MP)
— Macros for interrupt service routine (ISR)

Some macro commands are only valid for a specific macro type. The last three columns
of the command table indicate whether the respective macro type supports the command.
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7.6.1

Basic Setting Functions

Icon Function Name Statement IT | MP | ISR
This function sets the pulse output mode
i8094H_SET_PULSE_MODE as either CW/CCW or PULSEIDIR for | o | ¢
the assigned axes and their direction
definition.
This function sets the maximum rate for
w i8094H_SET_MAX_V the output pulses (speed). A larger value © | O
will cause a rougher resolution.
i8094H SET HLMT This function s_,et§ the.actl\_/e logic level of o | o
- - the hardware limit switch inputs.
This function sets the motion stop mode
ELen i8094H_LIMITSTOP_MODE of the axes when the corresponding limit | © | ©
switches are detected.
. This function sets the trigger level of the
m 18094H_SET_NHOME near home sensor (NHOME). © |0
. This function sets the trigger level of the
ﬂ i8094H_SET_HOME_EDGE home sensor (HOME), o | ©
% i8094H_SET _SLMT This function sets the software limits. o | ©
# i8094H_CLEAR_SLMT This function clears the software limits. o | ©
G | i8094H_SET ENCODER This function sets the encoder input o | o
B related parameters.
g . This function outputs a DO signal
on 18094H_SERVO_ON (ENABLE) to enable the motor driver. © |0
. This function outputs a DO signal
% 18094H_SERVO_OFF (ENABLE) to disable the motor driver. © |0
g i8094H_SET_ALARM This function sets the ALARM input o lo
signal related parameters.
i8094H_SET_INPOS This function sets the INPOS input signal ol o
related parameters.
This function selects the axes and sets the
i8094H_SET_FILTER time constant for digital filters of the oo
input signals.
This function enables the linear counter
@ i8094H_VRING_ENABLE of the assigned axes as variable ring © | O
counters.
| i8094H_VRING_DISABLE This functlon_dlsables the variable ring o | o
counter function.
This function prevents a triangle form in
: linear acceleration (T-curve) fixed pulse
I‘, 18094H_AVTRI_ENABLE driving even if the number of output ©l0
pulses is low.
This function disables the function that
h i8094H_AVTRI_DISABLE prevents a triangle form in linear © | O

acceleration fixed pulse driving.
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7.6.2

Status Functions

Icon Function Name Statement IT MP | ISR
This function sets the command position
i8094H_SET _LP counter value (logical position counter, @) @)
LP).
This function reads the command
i8094H_GET_LP position counter value (logical position ©) ©)
counter, LP).
[EP| This function sets the encoder position
i8094H_SET_EP counter value (real position counter, or © ©)
L] EP).
EPJ| | . This function reads the encoder position
18034H_GET_EP counter value (EP). © ©
_@_ i8094H GET DI This function reads the digital input (DI) o o
- - status.
~°. | i8094H_GET ERROR This function checks whether an error o o
Lot occurs or not.
ﬁ i8094H_GET_ERROR_CODE This function reads the ERROR status. © (@)
7.6.3 FRnet DIO Functions
Icon Function Name Statement IT MP | ISR
This function reads the FRnet digital
. input signals. One group comprises 16
‘ 18094H_FRNET_IN bits data. Therefore, total 128 DI can be © ©
defined for one FRnet interface.
This function writes data to the FRnet
. digital output. One group comprises 16
.. 18094H_FRNET_OUT bits data. Therefore, total 128 DO can © ©
be defined for one FRnet interface.
7.6.4 Auto Home Functions
Icon Function Name Statement IT MP | ISR
E W \ i8094MF_SET HV This function sets the homing speed. ©
- This function sets the Limit Switch to be
E‘_LJ 18094MF_HOME _LIMIT used as the HOME sensor. ©
. This function sets the homing method
m 18094MF_SET_HOME_MODE and other related parameters. ©
ED‘ i8094MF_HOME _START This function starts the home search of o

assigned axes.
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7.6.5

Axis Move Functions

Function Name

Statement

i8094H_NORMAL_SPEED

The function sets the speed mode.

i8094H_SET_SV

This function sets the start speed for the
assigned axes.

i8094H_SET_V

This function sets the desired speed for
the assigned axes.

i8094H_SET_A

This function sets the acceleration value
for the assigned axes.

i8094H_SET D

This function sets the deceleration value
for the assigned axes.

i8094H_SET K

The function sets the acceleration rate
(i.e., Jerk) value for the assigned axes.

i8094H_SET L

This function sets the deceleration rate
(i.e., Jerk) value for the assigned axes.

©O|lo|o0o|o0o|O0| 0|0

i8094H_SET_AO

This function sets the number of
remaining offset pulses for the assigned
axes. Please refer to the figure below for
a definition of the remaining offset pulse
value.

i8094H_FIXED_MOVE

Command a point-to-point motion for
several independent axes.

i8094H_SET_PULSE

This function sets the pulse number for
fixed pulse driving.

SB= I PPPPPPEE

i8094H_CONTINUE_MOVE

This function issues a continuous motion
command for several independent axes.

7.6.6

Interpolation Functions

Icon

Function Name

Statement

MP

ISR

R

i8094H_AXIS_ASSIGN

This function assigns the axes to be used
for interpolation. Either two or three axes
can be assigned using this function.
Interpolation commands will refer to the
assigned axes to construct a working
coordinate system. The X axis does not
necessarily have to be the first axis.
However, it is easier to use the X axis as
the first axis, the Y axis as the second
axis, and the Z axis as the third axis.

2

i8094H_VECTOR_SPEED

This function assigns the mode of
interpolation. Either two or three axes
will join this interpolation. Each
interpolation mode will refer to some
assigned axes that construct a working
coordinate system. The assigned axes are
defined by i8094H_AXIS_ASSIGN()
function. The X axis does not necessarily
have to be the first axis. However, it is
easier to let the X axis as the first axis,
the Y axis as the second axis, and the Z
axis as the third axis in applications.
Different modes need different settings.
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Please refer to the mode definitions.

Y

i8094H_SET_VSV

This function sets the starting speed of
the principle axis (axis 1) for the
interpolation motion.

e

Pz

i8094H_SET_VV

This function sets the vector speed of the
interpolation motion. Users do not need
to assign any axes on this function. The
speed setting will take effect on the
current working coordinate system which
is defined by the
i8094H_AXIS_ASSIGN() function.

D_;’

i8094H_SET_VA

This function sets the vector acceleration
for interpolation motion. Users do not
have to assign any axes on this function.
This speed setting will take effect on the
current working coordinate system which
is defined by the
i8094H_AXIS_ASSIGN() function.

i8094H_SET_VD

This function sets the deceleration value
for the interpolation motion.

i8094H_SET_VK

Set the acceleration rate (jerk) value for
interpolation motion.

SIS

i8094H_SET_VL

This function sets the deceleration rate of
the interpolation motion.

i

(o]

i8094H_SET_VAO

Set this value will cause the motion
control chip to start deceleration earlier.
The remaining offset pulses will be
completed at low speed to allow the
controller to stop immediately when the
offset pulse value has been reached.
Please refer to the figure below for more
information.

i8094H_LINE_2D

This function executes a 2-axis linear
interpolation motion.

i8094H_LINE_3D

This function executes a 3-axis linear
interpolation motion.

i8094H_ARC_CW

This function executes a 2-axis circular
interpolation motion in a clockwise (CW)
direction.

i8094H_ARC_CCW

This function executes a 2-axis circular
interpolation motion in a counter-
clockwise (CCW) direction.

i8094H_CIRCLE_CW

This function executes a 2-axis circular
interpolation motion in a clockwise (CW)
direction.

T & P8 @

i8094H_CIRCLE_CCW

This function executes a 2-axis circular
interpolation motion in a counter-
clockwise (CCW) direction.
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7.6.7

Synchronous Action Functions

Icon

Function Name

Statement

MP

ISR

&

i8094H_SYNC_ACTION

This function sets the activation factors
(provocative) and the specified action
when a specified activation factor
occurs.

B

i8094H_SET_COMPARE

This function sets the values of
COMPARE registers. However, it will
disable the functions of software
limits.

—
=

T

i8094H_GET_LATCH

This function gets the values from the
LATCH register.

0|
)
m

i8094H_SET_PRESET

This function sets the PRESET value
for synchronous action.

all

i8094H_SET_OUT

This function sets the pulse by
collocated the
i8094H_SYNC_ACTION function.

7.6.8

Continuous Interpolation Functions

Icon

Function Name

Statement

MP

ISR

i8094H_RECTANGLE

Continuous interpolation will be
performed to create a rectangular
motion, which is formed by 4 lines and
4 arcs. The length of each side can be
changed. The radius of each arc is the
same and it can also be changed. The
deceleration point will be calculated
automatically. This is a command
macro command that appears in
various motion applications.

i8094H_LINE_2D_INITIAL

This function sets the necessary
parameters for a 2-axis continuous
linear interpolation using symmetric T-
curve speed profile.

i8094H_LINE_2D_CONTINUE

This function executes a 2-axis
continuous linear interpolation.

i8094H_LINE_3D_INITIAL

This function sets the necessary
parameters for a 3-axis continuous
linear interpolation using symmetric T-
curve speed profile.

i8094H_LINE_3D_CONTINUE

This function executes a 3-axis
continuous linear interpolation.

i8094H_MIX_2D_INITIAL

This function does the initial settings
for mixed linear and circular 2-axis
motions in continuous interpolation.

i8094H_MIX_2D_CONTINUE

This function executes mixed linear
and circular 2-axis motion in
continuous interpolation.

i8094H_HELIX_3D

This function performs a 3-axis helical
motion.

Fe- @ @0NN T

i8094H_RATIO_INITIAL

This function sets the Initial values for
ratio motion (motion in ratio) using a
symmetric T-curve speed profile.
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i8094H_RATIO 2D

This function executes a two-axis ratio

w&' motion.
7.6.9 Interrupt Control Functions
Icon Function Name Statement IT MP | ISR
@ i8094H_ENABLE_INT This function enables the interrupt. o
i8094H DISABLE INT ThIS function disables the o
- - interrupt.
4' i8094H_INTFACTOR_ENABLE This function sets the interrupt factors. ©
:} i8094H_INTFACTOR_DISABLE ;I:litsolr‘gnction disables the interrupt o
7.6.10 Other Functions
Icon Function Name Statement [T MP | ISR
This command is usually used when
users desire to start multi-axis driving
simultaneously. When this command is
issued, users may write other driving
commands to the control card. All the
. driving commands will be held after
u 18094H_DRV_START i8094H_DRV_HOLD() is issued, and © ©
these commands will be started once the
i8094H_DRV_START() is issued.
However, if in driving, this command
will not cause the driving to be stopped.
But the next command will be held.
This command releases the holding
III i8094H_DRV_HOLD status, and start the driving of the (@) ©
assigned axes immediately.
. This function immediately stops the
IE:lng i8094H_STOP_SUDDENLY ssigned axes ©
. This function decelerates and finally
g 18094H_STOP_SLOWLY stops the assigned axes slowly. ©
. This function stops interpolation motion
Eﬂg 18094H_VSTOP_SUDDENLY of the assigned module immediately. ©
This function stops interpolation motion
I:l i8094H_VSTOP_SLOWLY of the assigned module in a decelerating @)
%50 way.
After using anyone of the stop
. functions, please solve the malfunction,
Iﬁ 18094H_CLEAR_STOP and then issue this function to clear the ©
stop status.
1. If the current motion status is
@ i8094H_INTP_END running a interpolation motion and you o

would like to issue a single axis motion
or change the coordinate definition,
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you should call this function before the

new command is issued.
2.You can redefine the MAX V for each
axis. In this way, you do not have to
execute i8094H_INTP_END() function.

7.6.11 Macro Program Functions
Icon | Function Name Statement LT MP | ISR
This function sets the number of the
ﬁ i8094H_MP_CALL macro program for jump executing @)
in the next procedure layer.
ﬁ i8094H_MP_SET VAR This function sets VARN to be the o
global value.
w i8094H_MP_SET_RVAR This function sets VARN to be the o
global return value.
This function issues the “addition”,
“subtraction” “multiplication”, and the
ﬁ i8094H_MP_VAR_CALCULATE “division” for supporting the variable ©
arithmetic operation. For example:
varNo (+-*/) varNol = varNo2.
. This function issues the “for loop”
ﬁ 18094H_MP_FOR condition statement. ©
. This function issues the “end of for
w 18094H_MP_NEXT loop” condition statement. ©
. This function issues the “If” condition
& 18094H_MP_IF statement. ©
. This function issues the “else”
@ 18094H_MP_ELSE condition statement. ©
- This function issues the “end of If”
W 18094H_MP_IF_END condition statement. ©
@ i8094H_MP_TIMER This function issues a procedure delay. ©
This function can be used to assign
. commands to be performed while
W 18094H_MP_STOP_WAIT waiting for all motion to be completed ©
(stopped).
This function sets the i-8094H module
ﬁ i8094H_MP_SET RINT to produce an interrupt signal with the @)

0x04 code to the WinCon controller.
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